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Safety Information
| Warning

TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE THE COVER (OR BACK).
NO USER-SERVICEABLE PARTS ARE INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

CAUTION

RISK OF ELECTRIC SHOCK
DO NOT OPEN

A

This symbol indicates "dangerous voltage"
inside the product that presents a risk of
electric shock or personal injury.

CAUTION: TO REDUCE THE RISK OF ELECTRIC
SHOCK, DO NOT REMOVE COVER (OR BACK).
NO USER SERVICEABLE PARTS INSIDE. REFER
SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol indicates important instructions
accompanying the product.

Do not install this equipment in a confined space
such as a bookcase or similar unit.

WARNING

To prevent damage which may result in fire
or electric shock hazard, do not expose this
appliance to rain or moisture.

CAUTION

Blu-ray Disc Player USES AN INVISIBLE LASER
BEAM WHICH CAN CAUSE HAZARDOUS
RADIATION EXPOSURE IF DIRECTED. BE SURE
TO OPERATE Blu-ray Disc Player CORRECTLY
AS INSTRUCTED.

CAUTION

THIS PRODUCT UTILIZES A LASER. USE

OF CONTROLS OR ADJUSTMENTS OR
PERFORMANCE OF PROCEDURES OTHER
THAN THOSE SPECIFIED HEREIN MAY RESULT
IN HAZARDOUS RADIATION EXPOSURE. DO
NOT OPEN COVERS AND DO NOT REPAIR
YOURSELF. REFER SERVICING TO QUALIFIED
PERSONNEL.

This product satisfies CE regulations when
shielded cables and connectors are used to
connect the unit to other equipment. To prevent
electromagnetic interference with electric
appliances, such as radios and televisions, use
shielded cables and connectors for connections.
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IMPORTANT NOTE

The mains lead on this equipment is supplied with
a molded plug incorporating a fuse. The value of
the fuse is indicated on the pin face of the plug.

If it requires replacing, a fuse approved to BS1362
of the same rating must be used.

Never use the plug with the fuse cover omitted

if the cover is detachable. If a replacement fuse
cover is required, it must be of the same colour as
the pin face of the plug. Replacement covers are
available from your dealer.

If the fitted plug is not suitable for the power points
in your house or the cable is not long enough to
reach a power point, you should obtain a suitable
safety approved extension lead or consult your
dealer for assistance.

However, if there is no alternative to cutting off the
plug, remove the fuse and then safely dispose of
the plug. Do not connect the plug to a mains jack,
as there is a risk of shock hazard from the bared
flexible cord.

To disconnect the apparatus from the mains, the
plug must be pulled out from the mains socket,
therefore the mains plug shall be readily operable.
The product unit accompanying this user manual
is licenced under certain intellectual property rights
of certain third parties.




CLASS 1 LASER PRODUCT

This Compact Disc player is classified as a CLASS
1 LASER product. Use of controls, adjustments
or performance of procedures other than those
specified herein may result in hazardous radiation
exposure.

CAUTION :

e CLASS 3B VISIBLE AND INVISIBLE LASER
RADIATION WHEN OPEN. AVOID EXPOSURE
TO THE BEAM. (IEC 60825-1)

e THIS PRODUCT UTILIZES A LASER.

USE OF CONTROLS OR ADJUSTMENTS

OR PERFORMANCE OF PROCEDURES
OTHER THAN THOSE SPECIFIED HEREIN
MAY RESULT IN HAZARDOUS RADIATION
EXPOSURE. DO NOT OPEN COVER AND DO
NOT REPAIR YOURSELF. REFER SERVICING
TO QUALIFIED PERSONNEL.

CLASS 1
KLASSE 1
LUOKAN 1
KLASS 1

LASER PRODUCT
LASER PRODUKT
LASER LAITE

LASER APPARAT

PRODUCTO LASER CLASE 1

Precautions

Important Safety Instructions

Read these operating instructions carefully before
using the unit. Follow all the safety instructions
listed below.

Keep these operating instructions handy for future
reference.

Read these instructions.

Keep these instructions.

Heed all warnings.

Follow all instructions.

Do not use this apparatus near water.

[ O

Clean only with a dry cloth.

10.

11.

12.

13.

14.

Do not block any ventilation openings. Install
in accordance with the manufacturer's
instructions.

Do not install near any heat sources such
as radiators, heat registers, stoves, or other
apparatus (including AV receivers) that
produce heat.

Do not defeat the safety purpose of the
polarized or grounding-type plug. A polarized
plug has two blades with one wider than the
other. A grounding type plug has two blades
and a third grounding prong. The wide blade
or the third prong are provided for your safety.
If the provided plug does not fit into your
outlet, consult an electrician for replacement
of the obsolete outlet.

Protect the power cord from being walked on
or pinched particularly at plugs, convenience
receptacles, and the point where it exits the
apparatus.

Only use attachments/accessories specified
by the manufacturer.

Use only with the cart,

stand, tripod, bracket,

or table specified by the

manufacturer, or sold with

the apparatus. When a cart

is used, use caution when

moving the cart/apparatus combination to
avoid injury from tip-over.

Unplug this apparatus during lightning storms
or when unused for long periods of time.

Refer all servicing to qualified service
personnel. Servicing is required when the
apparatus has been damaged in any way,
such as when the power-supply cord or plug
is damaged, liquid has been spilled or objects
have fallen into the apparatus, the apparatus
has been exposed to rain or moisture, does
not operate normally, or has been dropped.
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Safety Information

e Holding Discs
- Fingerprints or scratches on o
a disc may reduce sound and S
picture quality or cause skipping.
- Avoid touching the surface of a disc where
data has been recorded.
- Hold the disc by the edges so that fingerprints
will not get on the surface.
- Do not stick paper or tape on the disc.
¢ Cleaning Discs
- If you get fingerprints or dirt on a
disc, clean it with a mild detergent
diluted in water and wipe with a
soft cloth.
- When cleaning, wipe gently from the inside to
the outside of the disc.
e Disc Storage
= Do not keep in direct sunlight.
= Keep in a cool ventilated area.
= Keep in a clean protection jacket and store
vertically.

Handling Cautions

® Do not expose this apparatus to dripping or
splashing. Do not put objects filled with liquids,
such as vases on the apparatus.

e To turn this apparatus off completely, you must
pull the power plug out of the wall socket.
Consequently, the power plug must be easily
and readily accessible at all times.

* Do not plug multiple electric devices into the
same wall socket. Overloading a socket can
cause it to overheat, resulting in a fire.
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e Before connecting other components to this
player, be sure to turn them off.

e |f you move your player suddenly from a cold
place to a warm place, condensation may occur
on the operating parts and lens and cause
abnormal disc playback. If this occurs, unplug
the player, wait for two hours, and then connect
the plug to the power outlet.

Then, insert the disc, and try to play back again.

e |f the product makes an abnormal noise or
produces a burning smell or smoke, turn off
the power switch immediately and disconnect
the power plug from the wall outlet. Then,
contact the nearest customer service centre for
technical assistance. Do not use the product.
Using the product as it is may cause a fire or an
electric shock.

Using the 3D function

IMPORTANT HEALTH AND SAFETY
INFORMATION FOR 3D PICTURES.

Read and understand the following safety
information before using the 3D function.

e Some viewers may experience discomfort while
viewing 3D TV such as dizziness, nausea, and
headaches.

If you experience any such symptom, stop
viewing 3D TV, remove the 3D Active Glasses,
and rest.

Watching 3D images for an extended period of
time may cause eye strain. If you feel eye strain,
stop viewing 3D TV, remove your 3D Active
Glasses, and rest.

A responsible adult should frequently check on
children who are using the 3D function.

If there are any reports of tired eyes, headaches,
dizziness, or nausea, have the child stop viewing
3D TV and rest.

Do not use the 3D Active Glasses for other
purposes (Such as general eyeglasses,
sunglasses, protective goggles, etc.).



¢ Do not use the 3D function or 3D Active Glasses
while walking or moving around. Using the 3D
function or 3D Active Glasses while moving
around may cause you to bump into objects,
trip, and/or fall, and cause serious injury.

e |f you want to enjoy 3D content, connect a 3D
device (3D compliant AV receiver or TV) to the
player's HDMI OUT port using a high-speed
HDMI cable. Put on 3D glasses before playing
the 3D content.

e The player outputs 3D signals only through
HDMI cable connected to the HDMI OUT port.

e As the video resolution in 3D play mode is fixed
according to the resolution of the original 3D
video, you can not change the resolution to your
preference.

e Some functions such as BD Wise, screen size
adjustment, and resolution adjustment may not
operate properly in 3D play mode.

® You must use a high-speed HDMI cable for
proper output of the 3D signal.

o Stay at least three times the width of the screen
from the TV when watching 3D images. For
example, if you have a 46-inch screen, stay 138
inches (11.5 feet) from the screen.

¢ Place the 3D video screen at eye level for the
best 3D picture.

¢ When the player is connected to some 3D
devices, the 3D effect may not function properly.

e This player does not convert 2D content into
3D.

e "Blu-ray 3D" and "Blu-ray 3D" logo are
trademarks of the Blu-ray Disc Association.

Copyright

© 2013 Samsung Electronics Co.,Ltd.

All rights reserved; No part or whole of this user's
manual may be reproduced or copied without the
prior written permission of Samsung Electronics
Co.,Ltd.
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Getting Started

Disc types and contents your player can play

Media Disc Type Details
Blu-ray DISC | gy 20w or BD-RE/-R recorded in the BD-RE format.
3D Blu-ray Disc
DVD-VIDEO
VIDEO DVD-RW
DVD-R DVD-VIDEO, recorded DVD+RW/DVD-RW(V)/DVD-R/+R that have been recorded and
finalized, or a USB storage media containing DivX, MKV, MP4 contents.
DVD+RW
DVD+R
CD-RW/-R, . '
Music recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media
MUSIC DVD-RW/R, | 1 taining MP3 or WMA contents
BD-RE/-R g '
CD-RW/-R, '
Photos recorded on CD-RW/-R, DVD-RW/-R, BD-RE/-R or a USB storage media
PHOTO DVD-RWIR, | ¢ ntaining JPEG contents
BD-RE/-R ¢ :
I NOTES |

» The player may not play certain CD-RW/-R and DVD-R because of the disc type or recording conditions.
» If a DVD-RW/-R has not been recorded properly in DVD video format, it will not be playable.
» Your player will not play content that has been recorded on a DVD-R at a bit-rate that exceeds 10 Mbps.

» Your player will not play content that has been recorded on a BD-R or USB device at a bit rate that exceeds 25 Mbps.

» Playback may not work for some types of discs, or when you use specific functions, such as angle change and aspect ratio
adjustment. Information about the discs is written in detail on the disc box. Please refer to this if necessary.

» When you play a BD-J title, loading may take longer than a normal title or some functions may perform slowly.

Disc types your player cannot play

e HD DVD

¢ DVD-ROM/PD/

MV, etc

| 8 English

¢ DVD-RAM e DVD-RW (VR mode) ¢ 3.9 GB DVD-R for
e Super Audio CD e CVD/CD-ROM/CDV/ Authoring.
(except CD layer) CD-G/CD-I/LD

(CD-Gs play audio only,
not graphics.)



Region Code

Both players and discs

are coded by region.

These regional codes must match for a disc to
play. If the codes do not match, the disc will not

play.

The Region Number for this player is displayed on
the rear panel of the player.

Region

Disc Type Code

Area

North America, Central America,
South America, Korea, Japan,
Taiwan, Hong Kong and South
East Asia.

Blu-ray Disc

Europe, Greenland, French
territories, Middle East, Africa,
Australia and New Zealand.

3

(™
&Y

India, China, Russia, Central and
South Asia.

The U.S., U.S. territories and
Canada

Europe, Japan, the Middle East,
Egypt, Africa, Greenland

Taiwan, Korea, the Philippines,
Indonesia, Hong Kong

DVD-VIDEO

Mexico, South America,
Central America, Australia,
New Zealand, Pacific Islands,
Caribbean

Russia, Eastern Europe, India,
North Korea, Mongolia

@0 ® 8ee

China

Logos of Discs the player can play

& Blu-ray
BlurayOisc 3D/ e
Blu-ray Disc 3D Blu-ray Disc
BO  jyve DIVX.
b ™ HD
BD-LIVE DivX

PAL broadcast System in UK.,
France, Germany, etc.

English 9 |
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Getting Started

Supported Formats

Video File Support

File Extension | Container Video Codec | Resolution Fra;?:s;ate Bit rate (Mbps)| Audio Codec
* i DivX 3.11/4/5/6
*.mkv
X MPEG4 SP/ASP
Jasf
my A H.264 BP/
.mp4 VKV MP/HP
*.3gp ASF Dolby Digital
*vro VP Motion JPEG | 1920x1080 LPCM
*.mpg (WMV v7v8, 6-30 30 ADPCM(MA, MS)
* mpeg 36P Microsoft | MSMPEG4 3 : MG
N MoV MPEG-4 v3 1280x720)
s HE-AAC
- FLv WMA
P VRO Window Media
*trp VOB Video v7,v8,v9 Dolby Digital Plus
* mov b MPEG(MP3)
*flv 1S MPEG?2 DTS (Core)
*vob
g SVAF MPEG1
m2ts VP6 6401480 4
.mts
" divx MVC 24/25/30 60
* webm WebM VP8 1920x1080 6~30 20 Vorbis
= Limitations

content is defective or corrupted.
- Normal playback is not guaranteed if the file’s container information is wrong or the file itself is

corrupted.

- The Seek (Jump) function is not available if the file’s index table is damaged.

depending on the network speed.
- Some USB/Digital camera devices may not be compatible with the product.

| 10 English

Video decoder
Supports up to H.264 Level 4.1. (Does not support FMO/ASO/RS)
Does not support VC1/AP/LA4.

Even when the file is encoded by a supported codec listed above, a file might not be played if its

Files having higher bit or frame rates than indicated in the table above may stutter when played back.

When you playback a file remotely through a network connection, video playback may stutter



CODECs except for WMW7, v8, MSMPEG4 v3,
MVC, VP6

1) Below 1280 x 720 : 60 frames max.

2) Above 1280 x 720 : 30 frames max.

Does not support GMC 2 or higher.

Supports SVAF (Top/Bottom, Side by Side).
Supports BD MVC Spec.

Audio decoder

- Supports WMA 10 PRO (Up to 5.1).

Does not support WMA lossless audio.
Supports ADPCM IMAMS.

Does not support ADPCM(A-Law, p-Law).
Does not support QCELP/AMR NB/WB.
Supports vorbis (Up to 2ch).

Supports DD+ (Up to 7.1ch).

0 Supported DivX subtitle file formats
*tixt, “.smi, *.srt, “.sub, *.txt

| NOTES |

» Playback of some DivX, MKV or MP4 file may not be
supported depending on their video resolution and frame
rate.

Supported Subtitle File Formats

e Extzlr::ion
MPEG-4 Timed text tixt
SAMI .smi
SubRip i
SubViewer .Sub
External Micro DVD sub or.txt
SubStation Alpha .8sa
Advanciilpsht;bStanon ass
Powerdivx .psb

Xsub AVI
SubStation Alpha MKV
Advanced SubStation
Internal Alpha MKV
SubRip MKV
MPEG-4 Timed text MP4
Music File Support
Al Type Codec | Support Range
Extension p pp 9
MPEG1
*mp3 MPEG Audio
Layer 3
*.mda
*.mpa MPEG4 AAC
*.aac
* flac FLAC FLAC | Supports up to 2ch
*.009 0GG Vorbis | Supports up to 2ch
Supports WMA 10
Pro (Upto 5.1).
Does not support
., WMA lossless audio.
wma WMA WMA Supports up o M2
profile.
Does not support
LBR mode.
*.wav wav wav
mid mid midi | type 0and type 1
* mid P p
*.ape ape ape

English 11 |
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Getting Started

Picture File Support

File Extension Type Resolution
JLDE% JPEG 15360x8640
*.png PNG 4096x4096
*.bmp BMP 4096x4096
*.mpo MPO 15360x8640

Notes on the USB connection

e Your player supports USB storage media, MP3

players, digital cameras, and USB card readers.

¢ Some USB/digital camera devices may not be
compatible with the player.

Your player supports the FAT16, FAT32, and
NTFS files systems.

Connect USB devices directly to the player's
USB port. Connecting through a USB cable
may cause compatibility problems.

Inserting more than one memory device into

a multi-card reader may cause the reader to
operate improperly.

The player does not support the PTP protocol.
Do not disconnect a USB device during a
"loading" process.

The bigger the image resolution, the longer the
image takes to display.

This player cannot play MPS files with DRM
(Digital Rights Management) downloaded from
commercial sites.

Your player only supports video that is under
30fps (frame rate).

Your player only supports USB Mass Storage
Class (MSC) devices such as thumb drives and
USB HDD. (HUB is not supported.)

[ 12 English

e Certain USB HDD Devices, multi-card readers

and thumb drives may not be compatible with

this player.

If some USB devices require excessive power,

they may be limited by the circuit safety device.

If playback from a USB HDD is unstable, provide

additional power by plugging the HDD into a

wall socket.

If the problem continues, contact the USB HDD

manufacturer.

SAMSUNG is not responsible for any data file

damage or data loss.

Your player does not support NTFS compressed,

sparse, or encrypted files.

- You can repair or format a USB device on
your Desktop PC. (MS-Windows OS only)

AVCHD (Advanced Video Codec High
Definition)

e This player can play back AVCHD format discs.
These discs are normally recorded and used in
camcorders.

The AVCHD format is a high definition digital
video camera format.

The MPEG-4 AVC/H.264 format compresses
images with greater efficiency than the
conventional image compressing format.

Some AVCHD discs use the "x.v.Color" format.
This player can play back AVCHD discs that use
"x.v.Color" format.

"x.v.Color" is a trademark of Sony Corporation.
"AVCHD" and the AVCHD logo are trademarks
of Matsushita Electronic Industrial Co., Ltd. and
Sony Corporation.

| NOTES |

» Some AVCHD format discs may not play, depending on
the recording conditions.
AVCHD format discs need to be finalized.

» "x.v.Color" offers a wider colour range than normal DVD
camcorder discs.



Accessories

Check for the supplied accessories shown below.

Batteries for Remote Control (AAA Size)

Quick Setup Guide

User Manual

{elol e

(o2 [+ F == [ e o

=

Remote Control
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Getting Started

Front Panel
PLAY/PAUSE BUTTON
STOP BUTTON n
OPEN/CLOSE BUTTON ——{ A >
POWER BUTTON o
[ [+
USB HOST
DISC TRAY
REMOTE CONTROL SENSOR
| NOTES |

» To upgrade the player's software through the USB Host jack, you must use a USB memory stick.

» When the player displays the Blu-ray Disc menu, you cannot start the movie by pressing the Play button on the player or the

remote control. To play the movie, you must select Play Movie or Start in the disc menu, and then press the button on
the remote control.

Rear Panel

N 9
—

6
-

HDMI OUT

HDMI OUT

DIGITAL AUDIO OUT

| 14 Engiish



Remote C

Tour of the Remote Control

After setup, allows you to set the input
source on your TV.
(This button is only available in Samsung TV.)

Turn the TV on and off.
(This button is only available for Samsung TVs.)

Turn the player on and off.

poveis Bumen 20 |

TV volume adjustment.

Press to open and close the disc tray. (This button is only available for Samsung TVs.)

Press the number buttons to operate
options.

Use to enter the disc menu. Use to enter the Popup menu/Title menu.

Press to skip backwards or forwards. Press to search backwards or forwards.

Press to stop a disc. Press to pause a disc.
Press to play a disc.
Press to use Apps.
Allows you to repeat a title, chapter, track
or disc.

Use to display the playback information.

Press to move to the Home screen.

Press to use the Tools menu.
Use to select menu items and change
menu values.

Return to the previous menu. Press to exit the menu.

These buttons are used both for menus
on the player and also several Blu-ray Disc
functions.

Press to search contents.

Press to use full screen function.
During the Blu-ray Disc/DVDs playback,
this button does not operate.

Press to switch the Blu-ray Disc/DVD's
subtitle language.

Use to access various audio functions on a
disc.

| NOTES |
» I the remote control does not operate properly:
- Check the polarity +/- of the batteries.
- Check if the batteries are drained.
- Check if the remote sensor is blocked by obstacles.
- Check if there is any fluorescent lighting nearby.

| CAUTION |

. e » Dispose of batteries according to local environmental
Seeccec® regulations. Do not put them in the household trash.

Installing batteries

eoooe
[ Ce.
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Connections

Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the HDMI
IN jack on your TV.

- Do not connect the power cord to the wall outlet until you have made all the other connections.
- When you change the connections, turn off all devices before you start.

I NOTES |

» If you use an HDMI-to-DVI cable to connect to your display device, you must also connect the Digital Audio Out on the player
to an audio system to hear audio.

An HDMI cable outputs digital video and audio, so you don't need to connect an audio cable.
Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user manual of your TV.

When you connect the player to your TV using the HDMI cable or to a new TV, and then turn it on for the first time, the player
automatically sets the HDMI output resolution to the highest supported by the TV.

» Along HDMI cable may cause screen noise. If this occurs, set HOMI Deep Colour to Off in the menu.
» To view video in the HDMI 720p, 1080i, or 1080p output mode, you must use a High speed (category 2) HDMI cable.

» HDMI outputs only a pure digital signal to the TV.
If your TV does not support HDCP (High-bandwidth Digital Content Protection), random noise appears on the screen.

v v v
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Connecting to an Audio System

You can connect the Blu-ray player to the audio system using the methods illustrated below.
- Do not connect the power cord to the wall outlet until you have made all the other connections.
- When you change the connections, turn off all devices before you start.

_ Connecting to an HDMI supported AV receiver

e Connect an HDMI cable (not supplied) from the HDMI OUT jack on the back of the product to the
HDMI IN jack on your receiver.
¢ Best quality (Recommended)

suonosuUU0) €0 I

_ Connecting to an AV receiver with Dolby Digital or DTS decoder

e Using a digital Optical cable (not supplied), connect the Optical Digital Audio Out jack on the product to
the Digital Optical In jack of the receiver.

e Good quality

¢ You will hear sound only through the front two speakers with Digital Output set to PCM.

Method 1 Method 2

English 17 |



Connections

Connecting to a Network Router Wireless Network

You can connect your player to your network

router using one of the methods illustrated below.

To use the AllShare network functionality, you
must connect your PC to your network as shown
in the illustrations.

The connection can be wired or wireless.

Wired Network

Broadband modem

(with integrated router)
Eﬁ_@» D Broadband

(=% () service

iD g Broadband
* service
A4 Broadband

modem

I NOTES |

» Your router or your Internet Service Provider's policies
may prevent the player from accessing Samsung's
software update server. If this occurs, contact your
Internet Service Provider (ISP) for more information.

» DSL users, please use a router to make a network
connection.

| 18 English

£) Wireless Router
[mi

S 7\
L‘

Broadband
service
| NOTES |
» If your wireless router supports DHCP, this player can use

v

v

v

v

v

a DHCP or static IP address to connect to the wireless
network.

Set your wireless router to Infrastructure mode. Ad-hoc
mode is not supported.

The player supports only the following wireless security
key protocols:

- WEP (OPEN/SHARED), WPA-PSK (TKIP/AES),
WPA2-PSK (TKIP/AES)

Select a channel on the wireless router that is not
currently being used. If the channel set for the wireless
router is currently being used by another device nearby, it
will result in interference and communication failure.

If you select the Pure High-throughput (Greenfield)
802.11n mode and set the Encryption type on your router
to WEP, TKIP or TKIP-AES (WPS2Mixed), the player will
not support a connection in compliance with new Wi-Fi
certification specifications.

Wireless LAN, by its nature, may cause interference,
depending on the operating conditions (router
performance, distance, obstacles, interference by other
radio devices, etc).



Settings

The Initial Settings Procedure The Home Screen

o The Home screen will not appear if you do not
configure the initial settings.

o The OSD (On Screen Display) may change in this
player after you upgrade the software version.

o The access steps may differ depending on the menu
you selected.

After you have connected the player to your TV,
turn on the TV and player. When you turn on the
player the first time, the player's Initial Settings
screen appears on the TV. The Initial Setting
procedure lets you set the On Screen Display
(OSD) and menu languages, the aspect ratio
(screen size), the network type, and connect

the player to your network. For complete Initial
Settings instructions, see the Quick Setup Guide.

| NOTES |

» If you skip Network Setup during the Initial Settings

procedure, you can configure your network settings later.

See "Configuring Your Network Connection" on pages

27~30 for instructions.

If you want to display the Initial Settings screen again and

make changes, select Settings > System > Setup in

the Home screen or select the Reset option. (See pages

23 or 26)

If you want to use an Anynet+(HDMI-CEC) function,

please follow the instructions below.

1) Connect the player to an Anynet-+(HDMI-CEC)-
compliant Samsung TV using HDMI Cable.

2) Set the Anynet-+(HDMI-CEC) feature to On in both the
TV and the player.

3) Set the TV to the Initial Settings Procedure.

v

v
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o Apps : Gives you access to various for pay or free-
of-charge applications you can download.

Photos, Videos & Music : Lets you play photos,
@ | videos or music content from Disc, USB, PC or
mobile devices.

Settings : Opens the player's menu where you
can set various functions to suit your personal
preferences.

Web Browser : Provides access to the Internet.

Recommended Apps : Gives you direct access to
recommended applications.

®

Movies & TV Shows : Lets you download Films and
TV Shows from the Internet.

O | INOTES|
» Depending on your country, this menu function
may not be supported.
| NOTES |

» If you leave the player in the stop mode for more than
5 minutes without using it, a screen saver will appear on
your TV, If the player is left in the screen saver mode for
more than 20 minutes, the power will automatically turn off.
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Select Settmgs on the Home screen, and
then press (&g button. The Settings screen
appears.

Settings

. Display
)
E -

) Network
™ Smart Features
©  system
2. To access the menus, sub-menus, and
options on the Settings screen, please refer
to the remote control illustration below.

Q Support

Buttons on the Remote Control Used
for the Settings Menu

@ | HOME Button : Press to move to the Home screen.

@ | RETURN Button : Return to the previous menu.

(Enter) / DIRECTION buttons :

e Press A'Y <> to move the cursor or select an

(3) item.

e Press the button to activate the currently
selected item or confirm a setting.

@ | EXIT Button : Press to exit the current menu.
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Detailed Function Information

Each Settings function, menu item, and individual
option is explained in detail on-screen. To view an
explanation, use the A ¥ €4 » buttons to select the
function, menu item, or option. The explanation
will usually appear on the right side of the screen.
A short description of each Settings function
starts on the next page. Additional information on
some of the functions is also in the Appendix of
this manual.



Settings Menu Functions

Display

3D Settings

Select whether to play a Blu-ray Disc with 3D contents

in 3D Mode.

e |f you move to the Home or Apps screen while in 3D
mode, the player will switch to 2D automatically.

sbumes 10 |

TV Aspect Ratio

Lets you adjust the output of the player to the screen
size and screen format of your TV.

BD Wise

BD Wise is Samsung's latest inter-connectivity feature.
When you connect a Samsung player and a Samsung
TV with BD Wise to each other via HDMI, and BD Wise
is on in both the player and TV, the player outputs video
at the video resolution and frame rate of the Blu-ray
Disc/DVD.

Resolution

Set the output resolution of the HDMI video signal to BD
Wise, Auto, 1080p, 1080i, 720p or 576p/480p.

The number indicates the number of lines of video per
frame.

The i and p indicate interlaced and progressive scan,
respectively. Generally, the more lines, the higher quality.

Movie Frame (24Fs)

If the player is connected to a 24Fs compatible TV,

setting the Movie Frame (24Fs) feature to Auto lets the

player adjust its HDMI output to 24 frames per second

automatically for improved picture quality.

e You can enjoy the Movie Frame (24Fs) feature only on
a TV supporting this frame rate.

¢ Movie Frame is only available when the player is in the
HDMI 1080i or 1080p output resolution modes.

DVD 24Fs Conversion

Converts DVD playback to 24 frames per second and
outputs outputs it via HDMI. This option is only available
when Movie Frame (24Fs) is set to Auto.

Smart Hub Screen Size

Lets you select the optimal size for the Smart Hub
Screen.

HDMI Colour Format

Lets you set the colour space format for the HDMI
output so that it matches the capabilities of the
connected device (TV, monitor, etc). The screen goes
black momentarily after you have selected a format.

HDMI Deep colour

Lets you set the product to output HDMI video with
Deep Colour. Deep Colour provides more accurate
colour reproduction with greater colour depth.

Progressive Mode

Lets you improve picture quality when viewing DVDs.
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Settings

Audio

Digital Output

Lets you select the digital audio output format that is
suitable for your TV or AV Receiver. For more details,
see the digital output selection table on page 64.

PCM Downsampling

Lets you choose to have 96Khz PCM signals
downsampled to 48Khz before they are outputted to an
amplifier. Choose On if your amplifier or receiver is not
compatible with a 96Khz signal.

Dynamic Range Control

Lets you apply dynamic range control to Dolby Digital,

Dolby Digital Plus, and Dolby TrueHD audio.

v Auto : Automatically controls the dynamic range of
Dolby TrueHD audio, based on information in the
Dolby TrueHD soundtrack. Also turns dynamic range
control on for Dolby Digital and Dolby Digital Plus.

v Off : Leaves the dynamic range uncompressed,
letting you hear the original sound.

v On : Turns dynamic range control on for all three
Dolby formats. Quieter sounds are made louder and
the volume of loud sounds is reduced.

Downmixing Mode

Lets you select the multi-channel downmix method that
is compatible with your stereo system. You can choose
to have the player downmix to normal stereo or to
surround compatible stereo.

DTS Neo:6 Mode

You can enjoy multichannel sound via HDMI output from
a 2 channel audio source.

Network

[ 22 English

Network Status

Lets you check the current network and Internet status.

Network Settings

Configure the network connection so you can enjoy
various features such as Internet services or AllShare
Wi-Fi functionality, and perform Software Updates.

Wi-Fi Direct

Lets you connect a Wi-Fi Direct device to the player
using a peer-to-pear network, without the need for a
wireless router.

Note that if the player is connected to a wireless network,
it may be disconnected when you use Wi-Fi Direct.

| NOTES |

» Text files, such as files with a .TXT or .DOC extension, will not
display when you are using the Wi-Fi Direct function.
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Network
AllShare Settings

Lets you control which devices on your network, such
as smart phones and tablets, can share content with
your TV.

Device Name

Lets you input a name for the player that will identify it
on your networks.

BD-Live Settings

sbumes 10 |

Set various BD-Live functions. BD-Live allows you to

access extra features available on some Blu-ray Discs if

you are connected to the Internet.

v BD-Live Internet Connection : Lets you fully allow,
partly allow, or prohibit a BD-Live Internet connection.

v BD Data Management : Manage BD data
downloaded from a BD-Live service or Blu-ray Disc.

Smart Features

Apps Settings

Lets you configure App notification settings and view

basic info about your Apps.

v Push Notification Settings : Receive notifications
from selected services.

v Properties : See basic info about Apps.

VOD Rating Lock

You can lock access to Video on Demand (VOD)
content based on its rating.
| NOTES |

» Depending on your country, this menu function may not be
supported.

Terms & Conditions,
Privacy Policy

You must review and agree to both the Smart Hub
Terms & Conditions and the privacy policy in order to
enjoy Smart Hub services.

Reset Smart Hub

Resets the Smart Hub and Samsung account settings
stored on your device.

System Setup

Lets you re-run the Initial Settings procedure. See the
Quick Setup Guide for details.

Quick Start

Lets you set the player to turn on quickly by decreasing
the boot time.
| NOTES |

» If this function is set to On, Standby power consumption will
be increased.

Language

You can select the language you prefer for the On-

screen menu, disc menu, audio, subtitles, etc.

¢ The language you select for the disc menu, disc
audio, or subtitles will only appear if it is supported on
the disc.
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System
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Device Manager

You can connect a wireless USB keyboard or mouse to
the USB port on the front of the player.

v Keyboard Settings : Lets you configure a wireless
USB keyboard connected to the player.
| NOTES |

» You can use the keyboard only when a QWERTY keyboard
screen or window appears in the Web Browser.

v Mouse Settings : Lets you configure a wireless USB
mouse connected to the player. You can use the
mouse in the player's menu and the Web Browser in
the same way you use a mouse on your PC.

= To use a mouse with the player's menu:

1. Connect the USB mouse to the player.

2. Click the primary button you selected in Mouse
Settings. The Simple Menu appears.

3. Click the menu options you want.
I NOTES |

» Some USB HID keyboards and mice may not be compatible
with your product.

» Some HID keyboard keys may not work.
» Wired USB keyboards are not supported.
» Some applications may not be supported.

» |f a wireless HID Keyboard does not operate because of
interference, move the keyboard closer to the player.




System

Security

The default security PIN is 0000. Enter the default PIN to
access the security function if you haven't created your
own PIN. After you have accessed the security function
for the first time, change the PIN using the Change PIN
function.

v BD Parental Rating : Prevents playback of Blu-ray
Discs with a rating equal to or above a specific age
rating you have set unless the PIN is entered.

v DVD Parental Rating : Prevents playback of DVDs
with a rating above a specific numerical rating you
have set unless the PIN is entered.

v Change PIN : Change the 4-digit PIN used to access
security functions.
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= |f you forget your PIN:

1. Remove any disc or USB storage device.

2. Press and hold the B button on the top panel for 5
seconds or more.
All settings will revert to the factory default settings.

General

You can change the options listed below to match your

preferences.

v Time Zone : Select the time zone in which you live.

v Menu Transparency : Adjust the transparency of the
menu box.

Anynet+ (HDMI-CEC)

Anynet+ is a convenient function that offers linked
operations with other Samsung players that have the
Anynet+ feature and lets you control those products
with one Samsung TV remote. To operate this function,
you must connect this player to an Anynet+ Samsung
TV using an HDMI cable.

DivX® Video On
Demand

View DivX® VOD Registration Codes to purchase and
play DivX® VOD contents.
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Support

Remote Management

When activated, lets Samsung Call Centre agents
diagnose and fix problems with the product remotely.
Requires an active Internet connection.

| NOTES |

» Remote Management service might not be available in some
countries.

» Contact your nearest service centre for your PIN code and tell
the code to the person in charge. It enables remote diagnosis
of the product and required measures.

Software Update

For more information about the Software Update
function, see "Upgrading Software" on pages 31~32.

Contact Samsung

Provides contact information for assistance with your
player.

Reset

Resets all settings to their default settings except for the
network and Smart Hub settings, and then launches the
Setup function.

The default security PIN is 0000.
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Networks and the Internet

When you connect this player to a network,

you can use network based applications and
functions such as Smart Hub and BD-LIVE,

and upgrade the player's software through the
network connection. For more information about
accessing and using Internet services, see the
Network Services chapter of this manual on pages
45~56. Instructions for configuring the network
connection start below.

Configuring Your Network Connection

Before you begin, contact your ISP to find out

if your IP address is static or dynamic. If it is
dynamic, and you have a wired or wireless
network, we recommend using the Automatic
configuration procedures described below.

If you are connecting to a wired network, connect
the player to your router using a LAN cable before
you start the configuration procedure.

If you are connecting to a wireless network,
disconnect any wired network connection before
you begin.

To begin configuring your network connection,
follow these steps:

Wired Network

0 Wired - Automatic

1. Inthe Home screen, select Settings, and
then press the (&) button.

2. Select Network, and then press the
button.

3. Select Network Settings, and then press the
button.

4. Select Wired in the Network Settings screen,
and then press the button.

5. Select Connect button, and then press the
button. The product detects the wired
connection, verifies the network connection
and then connects to the network.

0 Wired - Manual

If you have a static IP address or the Automatic
procedure does not work, you'll need to set the
Network Settings values manually.

Follow Steps 1 and 2 in Wired Network, and then
follow these steps:

1. Select Network Status. The player searches
for a network, and then displays the
connection failed message.

2. On the bottom of the screen, select IP
Settings, and then press the button.
The IP Settings screen appears.

3. Select the IP Setting field, and then press the
button.

4. Select Enter manually in the IP Setting field,
and then press the button.

5. Select a value to enter (IP Address, for
example), and then press the button.
Use the number keypad on your remote
control to enter the numbers for the value.
You can also enter numbers using the AY
buttons. Use the <€ » buttons on the remote
control to move from entry field to entry field
within a value. When done with one value,
press the [&) button.

6. Pressthe A or ¥ button to move to another
value, and then enter the numbers for that
value following the instructions in Step 5.

7. Repeat Steps 5 and 6 until you have filled in
all values.

| NOTES |
» You can get the Network values from your Internet
provider.

8. When finished entering all the values, select
OK, and then press the [&] button. The
player verifies the network connection and
then connects to the network.
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Settings

Wireless Network

You can setup a wireless network connection in
four ways:

- Wireless Automatic

- Wireless Manual

- WPS(PBC)

- WPS(PIN)

When you configure the wireless network
connection, any wireless network devices currently
connected through the player or, if applicable,
the player's current wired connection, will be
disconnected.

Q Wireless - Automatic

1. Inthe Home screen, select Settings, and
then press the [&] button.

2. Select Network, and then press the
button.

3. Select Network Settings, and then press the
button.

4. Select Wireless in the Network Settings
screen, and then press the [&) button. The
player searches for and then displays a list of
the available networks.

Network Settings
Select your network type.
N
Wireless network [

« linksys3

‘ You can connect your Blu-ray

player tothe inteme. Please
select which wireless network to
wse.

Refresh WPSIPBC)
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5. Select the desired network, and then press
the [&] button.

6. On the Security screen, enter your network's
Security Code or Pass Phrase.
Enter numbers directly using the number
buttons on your remote control. Enter letters
by selecting a letter with an arrow button, and
then pressing [€] button.

| NOTES |

» To view the password as you enter it, use the arrow
buttons to select Show Password on the right side, and
then press (&) button.

7. When done, select Done and then press the
button. The player verifies the network
connection and then connects to the
network.

8. When verification is complete, select OK, and
then press the [&] button.
I NOTES |

» You should be able to find the Security Code or Pass
Phrase on one of the set up screens you used to set up
your router or modem.

0 Wireless - Manual

If you have a static IP address or the Automatic
procedure does not work, you'll need to set the
Network Settings values manually.

1. Follow the directions in Wireless - Automatic
through Step 5.

2. The player searches for a network, and then
displays the connection failed message.

3. On the bottom of the screen, select IP
Settings, and then press the button.
The IP Settings screen appears.

4. Select the IP Setting field, and then press the
button.

5. Select Enter manually in the IP Setting field,
and then press the [&) button.



6. Select a value to enter (IP Address, for
example), and then press [E] button. Use
the number keypad on your remote control
to enter the numbers for the value. You can
also enter numbers using the A 'Y buttons.
Use the € » buttons on the remote control
to move from entry field to entry field within a
value. When done with one value, press the
button.

7. Pressthe A or V¥ button to move to another
value, and then enter the numbers for that
value following the instructions in Step 6.

8. Repeat Steps 6 and 7 until you have filled in
all values.

| NOTES |

» You can get the Network values from your Internet
provider.

9. When finished, select OK, and then press the
button. The Security Screen appears.

10. On the Security screen, enter your network's
Security Code or Pass Phrase. Enter
numbers directly using the number buttons
on your remote control. Enter letters by
selecting a letter with the A ¥ «» buttons,
and then pressing the button.

11. When finished, select Done at the right of the
screen, and then press the button.
The player verifies the network connection
and then connects to the network.

12. After the player verifies the network, select
OK, and then press the [&] button.

2 WPS(PBC)

1. Inthe Home screen, select Settings, and
then press the (&) button.

2. Select Network, and then press the
button.

3. Select Network Settings, and then press the
button.

4. Select Wireless in the Network Settings
screen, and then press the button.

5. Pressthe A button on your remote, and then
press the » button to select the WPS(PBC).

6. Pressthe button on your remote. The
"Press the PBC button" message appears.

7. Press the WPS(PBC) button on your router
within two minutes. Your player automatically
acquires all the network settings values it
needs and connects to your network.

The Network Status screen appears. The
player connects to the network after the
network connection is verified.

2 WPS(PIN)

Before you begin, open the router's setup menu
on your PC and access the screen with the WPS
PIN entry field.

1. Inthe Home screen, select Settings, and
then press the [&) button.

2. Select Network, and then press the
button.
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3. Select Network Settings, and then press the
button.

4. Select Wireless in the Network Settings
screen, and then press the button.
The player searches for and then displays a
list of the available networks.

5. Select the desired network, and then press
the » button.

6. Select the WPS(PIN), and then press the
button. The PIN pop-up appears.

7. Enter the PIN into the WPS PIN entry field in
the router's Set Up screen and then save the
the screen.

| NOTES |

» Contact the manufacturer of the router for instructions
explaining how to access the route's Set Up screens or
refer to the router's user's manual.

For WPS connection, set your wireless router’s security
encryption to AES. Setting to WEP security encryption
does not support WPS connection.

v
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Wi-Fi Direct

The Wi-Fi Direct function allows you to connect
Wi-Fi Direct devices to the player and each other
using a peer-to-peer network, without a wireless
router.

I NOTES |

» Some Wi-Fi Direct devices may not support the AllShare
function if connected via Wi-Fi Direct. If this is the case,
it is advisable to change the network connection method
between devices.

» Bluetooth transmissions can interfere with the Wi-Fi
Direct signal. Before you use the Wi-Fi Direct function,
we strongly recommend that you turn off the Bluetooth
function of any active mobile device.

1. Turn on the Wi-Fi direct device and activate

its Wi-Fi Direct function.

2. Inthe Home screen, select Settings, and

then press the [&] button.

3. Select Network, and then press the

button.
4. Select Wi-Fi Direct, and then press the
button.

The Wi-Fi Direct devices that you can
connect appear.

5. You have three ways to complete the Wi-Fi
connection:

e Through the Wi-Fi device.
e Through the player using PBC.

e Through the player using a PIN.
Each is covered below.

Through the Wi-Fi Device

1. On the Wi-Fi device, follow the procedure on
the device for connecting to another Wi-Fi
Direct device. See the device's user manual
for instructions.
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2. When you have completed the procedure,
you should see a pop-up on your TV screen
saying that a device that supports Wi-Fi
Direct has requested to connect. Select OK,
and then press the button to accept.

3. The Connecting pop-up appears, followed
by the Connected pop-up. When it closes,
you should see the device listed on the Wi-Fi
Direct screen as connected.

Through the Player Using PBC

1. Select the Wi-Fi Direct device you want to
connect to this player, and then press the
button. The PBC/PIN pop up appears.

2. Select PBC, and then press the button.
The PBC pop-up appears.

3. Press the PBC button on the Wi-Fi Direct
device within 2 minutes.

4. The Connecting pop-up appears, followed
by the Connected pop-up. When it closes,
you should see the device listed on the Wi-Fi
Direct screen as connected.

Through the Player Using a PIN

1. Select the Wi-Fi Direct device you want to
connect to this player, and then press the
button. The PBC/PIN pop up appears.

2. Select PIN, and then press the button.
The PIN pop-up appears.

3. Note the PIN code in the pop-up, and then
enter it into the appropriate field in the Wi-Fi
Direct device you want to connect.

4. The Connecting pop-up appears, followed
by the Connected pop-up. When it closes,
you should see the device listed on the Wi-Fi
Direct screen as connected.

| NOTES |

» The current wired or wireless network connection will be
disconnected when you use the Wi-Fi Direct function.

» Text files, such as files with a . TXT or .DOC extension, will
not display when you are using the Wi-Fi Direct function.



Upgrading Software

The Software Update menu allows you to
upgrade the player's software for performance
improvements or additional services.

o Never turn the player off or back on manually during
the update process.

In the Home screen, select the Settings, and

then press the [&] button.

Select Support, and then press the
button.

Select Software Update, and then press the

button.
To download update software and update

now, select Update Now, and then press the
button. See Update Now on this page for

details.

To let the product download update software

automatically when available, select Auto

Update, and then press the button. See

Auto Update on page 32 for details.

| NOTES |

>

v

v

v

The upgrade is complete when the player turns off, and
then turns on again by itself.

Samsung Electronics shall takes no legal responsibility
for player malfunction caused by an unstable Internet

connection or consumer negligence during a software
Update.

If you want to cancel the upgrade while the upgrade
software is downloading, press the button.
When a system upgrade is in progress, "UPDATE" is
displayed on the front panel.

Update Now

You can use Update Now to update the software
through your network connection or by using a
USB flash drive. The network instructions are
below. The USB flash drive instructions are on the
next page.

1. Select Update Now, and then press the
button.
The Update now pop-up appears.

2. The product searches on line for the latest
software version.

3. Ifitfinds a new version, the Update Request
pop-up appears.

4. Select OK. The product upgrades the
software, turns off, and then turns on
automatically.

5. If you do not select OK or Cancel in one
minute, the product stores the new upgrade
software. You can upgrade the software later
using Auto Update.

6. If you select Cancel, the product cancels the
upgrade.
| NOTES |
» When the system upgrade is done, check the software
details in the Product Information section of the Contact
Samsung screen.

» Do not turn off the player during the Software Update. It
may cause the player to malfunction.
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Auto Update

You can set the Auto Update function so that the
player downloads new upgrade software when it
is in Auto Update mode.

In Auto Update mode, the player is off, but its
Internet connection is active. This allows the player
to download upgrade software automatically,
when you are not using it.

1. Pressthe AV buttons to select Auto
Update, and then press the button.

2. Select On or Off.
If you select On, the player will automatically
download new upgrade software when it is
in Auto Update mode with the power off. If it
downloads new upgrade software, the player
will ask you if you want to install it when you
turn the player on.

I NOTES |

» To use the Auto Update Mode Upgrade function, your
player must be connected to the Internet.

< By USB >

1. Visit www.samsung.com.
Click SUPPORT on the top right of the page.
Enter the product's model number into the
search field. As you enter the model number,

a drop down will display products that match
the model number.

4. Left click your product's model number in the
drop down list.

5. On the page that appears, scroll down to and
then click Firmware Manuals & Downloads.

Click Firmware in the centre of the page.

Click the ZIP button in the File column on the
right side of the page.

8. Click Send in the first pop-up that appears.
Click OK'in the second pop-up to download
and save the firmware file to your PC.
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9. Unzip the zip archive to your computer. You
should have a single folder with the same
name as the zip file.

10. Copy the folder to a USB flash drive.
11. Make sure no disc is inserted in the product,

and then insert the USB flash drive into the
USB port of the product.

12. In the product’s menu, go to Settings >
Support > Software Update.

13. Select Update Now.

14. The product searches for the software on the

USB drive. When it finds the software, the
Update Request pop-up appears.
15. Select OK. The product upgrades the

software, turns off, and then turns on
automatically.

| NOTES |

» There should be no disc in the player when you upgrade
the software using the USB jack.

» When the system upgrade is done, check the software
details in the Product Information section of the Contact
Samsung screen.

» Do not turn off the player during the Software Update.
It may cause the player to malfunction.

» Software Updates using the USB jack must be performed
with a USB flash memory stick only.



Medlia Play

Your Blu-ray Disc Player can play content located
on Blu-ray/DVD/CD discs, USB devices, PCs,
smart phones, tablets, and on the Web.

To play content located on your PC or on mobile
devices, you must connect them and this product
to your network. To play content on your PC, you
must also install Allshare network software on your
PC.

| NOTES |

» PCs running Windows 7 and Windows 8 have Allshare
software (Play To) built in.

The AllShare Play Screen

For all media, the AllShare Play Main screen or
one of its sub screens is your primary means of
accessing and playing contents saved on a variety
of devices, either connected directly or using your
network.

Accessing the AllShare Play Screen

To access the AllShare Play Main screen, select
Photos, Videos & Music on the Home screen,
and then press the button.

Playing Commercial Discs

1. Press the B button to open the disc tray.

2. Place a disc gently into the disc tray with the
disc’s label facing up.

3. Press the B button to close the disc tray.
Playback starts automatically.

If playback does not start automatically, press
the (@ button on the remote control.

Playing Files on a USB Device

There are two methods you can use to play or
view multimedia files located on a USB device
through your player.

Method 1

1. Turn the player on.

2. Connect the USB device to the USB port on
the front panel of the player. The New Device
Connected pop-up appears.

New device connected.

meo
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| NOTES |
» If the pop-up does not appear, go to Method 2.

3. Usethe AY buttons to select Photos,
Videos, Music or All Content, and then
press the (&) button. The AllShare Play
screen appears listing the content of the
device. Depending on how the contents is
arranged, you will see either folders, individual
files, or both.
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Media Play

I NOTES |

» Even though the player will display folders for all content
types, it will only display files of the Content Type you
selected in Step 2. For example, if you selected music,
you will only be able to see music files. You can change
this selection by returning to the All Share Play screen and
going to Step 4 in Method 2 below.

4. If necessary, use the the A Y «» buttons
to select a folder, and then press the
button.

5. Select a file to view or play, and then press
the (&) button.
6. Press the RETURN button to exit a folder

or the EXIT button to return to the Home
screen.

7. Go to pages 37~44 for instructions that
explain how to control playback of videos,
music, and pictures on a USB device.

Method 2

1. Turn the player on.

2. Connect the USB device to the USB port on
the front panel of the player.

3. Select Photos, Videos & Music on the
Home screen, and then press the button.

4. Select Photos, Videos, Music or All
Content, and then press the button.

I NOTES |

» Even though the player will display folders for all content
types, it will only display files of the Content Type you
selected in Step 2. For example, if you selected music,
you will only be able to see music files. You can change
this selection by returning to the AllShare Play screen and
repeating Step 4.

5. Use the € » buttons to select the desired
device and then press the button.
Depending on how the contents are
arranged, you will see either folders, individual
files, or both.
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6. If necessary, use the A Y «» buttons to
select a folder, and then press the [&] button.

7. Usethe AV «» buttons to select a file to
view or play, and then press the button.

8. Press the RETURN button to exit a folder or
the EXIT button to return to Home screen.

9. Go to pages 37~44 for instructions that
explain how to control playback of videos,
music, and pictures on a USB device.

I NOTES |

» If you insert a disc when playing a USB device, the device
mode changes to "Disc" automatically.

Playing a Disc with User Recorded
Content

You can play multimedia files you have recorded
on Blu-ray, DVD, or CD discs.

1. Place a user recorded disc into the disc
tray with the disc’s label facing up, and then
close the tray. The Device Connected pop-up
appears.

2. Usethe A'Y buttons to select the type of
content you want to view or play - Photos,
Videos, Music, or All Content - and then
press the [&) button.

| NOTES |

» Even though the player will display folders for all content
types, it will only display files of the Content Type you
selected in Step 2. For example, if you selected music,
you will only be able to see music files. You can change
this selection by returning to the AllShare Play screen and
repeating Step 2.

3. Ascreen appears listing the contents of the
disc. Depending on how the contents are
arranged, you will see either folders, individual
files, or both.



4. If necessary, use the A Y «» buttons to
select a folder, and then press the [&) button.

5. Usethe AY «» buttons to select a file to
view or play, and then press the button.

6. Press the RETURN button one or more times
to exit a current screen, exit a folder, or to
return to the Home screen.

Press the EXIT button to return directly to the
Home Screen.

7. Go to pages 37~44 for instructions that
explain how to control playback of videos,
music, and pictures on a disc.

Using the Allshare Network
Function

Allshare software lets you play Photos, Videos,
or Music located on your PC or your Allshare
compatible device through the player using a
wireless connection.

To Download the Allshare Software

If your PC is not running Windows 7 or 8, you must
install Allshare software on your PC to use the
Allshare function. You can download the Allshare
software and get detailed instructions for using the
Allshare software from the Samsung.com website.

1. Go to www.samsung.com.
2. Click Support at the top of the page.

3. On the Support page, enter the model
number of your player into the Model Number
field, and then press the [&] button.

4. On the page that appears, click See All
Downloads on the left side of the screen
under Downloads. The Download Tab
appears.

5. On the Download Tab, click Software.

6. In the list of software, click the EXE button on
the right side of the Allshare software line.

7. Inthe pop-up that appears, click the Send
button.

8. In the next pop-up, click Save File.

9. Find the Allshare install file on your disk, and
then double click the file.

10. In the pop-up that appears, click Run, and
then follow the directions that appear on your
screen.

Download the Allshare software Installation/
Instruction manual from the same Software Tab by
clicking the corresponding PDF file symbol in the
File column on the right. The file, in PDF format,
will download and open. You can view and/or
save the file.
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Media Play

Playing Content Located on Your PC
or Allshare Device through the Blu-ray
Disc Player

PC Blu-ray Disc Player

!

Play back
PC's files

AllShare Connection

1. Connect the Blu-ray Disc Player, your PC,
and/or your Allshare compatible device to the
same wireless network.

2. Follow the directions in the Allshare software
Installation/Instruction manual to set up
devices and files for playing or viewing.

3. Select Photos, Videos & Music on the
player's Home screen, and then press
the button. The AllShare Play screen
appears.

4. Select the type of content you want to play
- Photos, Videos, Music, or All Content -
and then press the button.

5. On the next screen, select Allshare, and then
press the [&) button.

6. In the list of Allshare connected devices that
appears, select your PC or other Allshare
compatible device, and then press the
button. A screen listing the available files
appears.

7. Select the file you want to play or view, and
then press the [&] button.
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Controlling the Playback of Content
Located on Your PC with Your Smart
Phone

PC Blu-ray Disc Player

' !

AllShare Control PC's files on the
Connection Blu-ray Disc Player

Allshare Smart Phone

(Only available with Samsung phones supporting
Allshare functionality.)

Play back
PC's files

1. Connect the Blu-ray Disc Player, your PC,
and your Allshare compatible cellular phone
to the same wireless network.

2. Follow the directions in the Allshare software
Installation/Instruction manual to set up
devices and files for playing or viewing.

3. On your computer, using the Allshare
software, confirm your phone is connected.

4. On the phone, select the file you want to view
or play, and then select the Blu-ray player as
the playback device.

5. On the phone, start playback.



Controlling Video Playback

You can control the playback of video content located on a Blu-ray/DVD disc, USB, mobile device or PC.
Depending on the disc or contents, some of the functions described in this manual may not be available.

Buttons on the Remote Control used for Video Playback

—= Using the disc menu, title menu, popup

menu, and title list

Playback related buttons
The player does not play sound in Search, Slow or

Step mode.
e To return to normal speed playback, press the
3 button.
3 button | Starts playback.
3 button | Stops playback.
D button | Pauses playback.
During playback, press the & or B3
Fast Motion | button.
Play Each time you press the & or B3
button, the playback speed will change.
. In pause mode, press the B3 button.
A AT Each time you press the B3 button, the
Play )
playback speed will change.
. In pause mode, press the [l button.
ﬁlt:p I GIEE Each time you press the ([ button, a
y new frame appears.
During playback, press the @& or &3
. . button.
g:;' 3 oty Each time you press @& or @ button,

the disc moves to the previous or next
chapter or file.

DISC MENU | During playback, press this button to
button display the Disc menu.

During playback, press this button to
TITLE MENU | display the Title menu.
button o [f your disc has a playlist, press the

View to go to the playlist.

POPUP MENU | During playback, press this button to
button display the Popup menu.

Using the Tools Menu

During playback or in pause mode, press the
TOOLS button.

Play from the
Beginning

Select to return to the beginning of the
movie, and then press the button.

3D

Use 3D menu to select Side by Side
or Top and Bottom option if the 3D
content currently playing does not
properly appear in 3D mode.

| NOTES |

» Use 3D menu for 3D contents only.
If applied to 2D contents, it may not
be displayed properly.

Movie Note

Movie Note provides information such
as director, cast, synopsis, etc.

I NOTES |

» This function is available if the disc
includes Movie Note information
and the player is connected to a
network.

Search Scene

You can use the Search Scene function
during playback to view or start a
movie from the scene of your choice.
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Media Play

I NOTES |

» If the index information in the file
is damaged or the file does not
support indexing, you will not be
able to use the Search Scene
function.

If you are using the Allshare function
after connecting to a computer
through your network, Search
Scene may not be supported.

Search Scene

v

If there is more than one movie on the
disc or device, select to start a different Repeat Mode
title.

1. Select Search Titles, and then
press the (&) button.
2. Use the A 'Y buttons to select

atitle, and then press the
button.

Search Titles

Select to play the chapter of your
choice.

1. Select Search Chapters, and then

h
S press the (& button.

Chapters

Select to repeat a title, chapter, or
specific section.

Off : Select to return to normal
playback.

- Title : Choose to repeat a selected
title.

Chapter : Choose to repeat a
specific chapter.

Repeat A-B : Choose to repeat a
specific section.

1. Press the AV buttons to select
repeat A-B, and then press the
button.

2. Press the (&) button at the point
where you want repeat play to start
(A). Let the movie play.

3. Press the (&) button at the point
where you want repeat play to stop
®).

I NOTES |

» You must set point (B) at least 5
seconds of playing time after point
(A.

2. Use the AV buttons to select a
chapter, and then press the
button.

Select to play the movie from a
selected time point.

1. Select Search Time Bar, and then
press the (&) button.

2. Using the number buttons, enter
the time point you want to go to,
and then press the button.

I NOTES |

» You can also use the < » buttons
to advance or rewind the movie.

Picture Mode

Search Time
Bar

Select to set the picture mode.
Dynamic : Increases sharpness and
brightness.

Standard : Choose this setting for
most viewing applications.

- Movie : The best setting for
watching movies.

User : Lets you adjust the sharpness
and noise reduction function
respectively.

I NOTES |

» When you use the BD wise function,
this menu will not appear.

The movie advances or rewinds one
minute each tme you press the < Audio
» buttons.

Select to set the desired audio
language.
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Select to set the desired subtitle Title Displays all the video files on the media
language. or storage device by title. —
i _ i i =
Subtitle EOU can ?'s"tﬁpesrﬁf:mig”g‘%"’” Displays all the folders with videos by &
ﬂ:’ pressTg et | ution on Date date. If you select a folder, and then =
© remote control. press the button, displays all the 8
Subtitle Select to set the desired subtitle videos in the folder by date. “_6
Settings options. Folder Displays all the folders on the media or E
Select to view a scene from another storage device.
angle. The Angle option displays the - . . .
Ao number of angles available to view. Playlist Displays available play lists.
9 When a Blu-ray Disc/DVD contains Displays all the video files on the media
multiple angles of a particular scene, Title List or storage device by title. Alternate to
you can change angle. Title.
BONUSVIEW | NOTES |
Video i i
= | Selecttoset the desired bonusiew » Depending on the disc or storage device, the View menu
BONUSVIEW | option. may differ or not be shown.
Audio
Using the Options Menu
Select to set the size of the video 9 P
Full screen image. Choose Original, Mode 1 On the video file playback screen, use the AV <>
(larger), or Mode 2 (largest). buttons to select Options and then press the
Information Select to view video file information. button.
| NOTES | Lets ypu preate a playlist by selectmg
specific files to play. It works essentially
» Depending on the disc or storage device, the Tools menu Play Selected | the same way for all media. See
may differ or not be shown. Creating a Playlist on an Audio CD on
» Video files with high bit rates of 20Mbps or more strain pages 41~42.
tr:ae ;;I:élsr s capabilities and may stop playing during Select to upload selected files to on-
piayback. line sites (Picasa, Facebook etc) or a
. . . device. To use this function, you need
Using the View & Options Menus S to establish an account with the on-line
site, and then log in using the Log In
Using the View Menu function.
On the video file playback screen, use the AV < » Delete Select to delete a file from a device.
buttons to select View and then press the
button. | NOTES |

» Depending on the disc or storage device, the Options
menu may differ or not be shown.
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Media Play

You can control the playback of music content
located on a DVD, CD, USB, mobile device or PC.
Depending on the disc or contents, some of the
functions described in this manual may not be
available.

Buttons on the Remote Control used
for Music Playback

Using the View & Options Menus

Using the View Menu

On the music file playback screen, use the AV <4 »
buttons to select View, and then press the
button.

NUMBER buttons : If numbered tracks are displayed,
© | press the number of a track.The selected track is
played.

O | ®EI button : Moves to the previous/next track.
© | O button : Stops a track.

Fast Play (Audio CD (CD-DA) only)

o During playback, press the &3 or B3 button.
Each time you press the & or B3 button, the
playback speed will change.

© | [ button : Pauses a track.
O | O3 button : Plays the currently selected track.

Displays all the music tracks on the
Track . .
media or storage device.
Album Displays all music on the media or
storage device by album.
. Displays all the the music files on the
Artist . . )
media or storage device by artist.
Displays all the music on the media or
Genre .
storage device by genre.
Folder Displays all Fhe folders on the media or
storage device.
I NOTES |

» Depending on the disc or storage device, the View menu
may differ or not be shown.

Using the Options Menu

On the music file playback screen, use the AY <4 »
buttons to select Options and press the (& button.

Lets you create a playlist by selecting
specific files to play. It works essentially

Play Selected | the same way for all media. See
Creating a Playlist on an Audio CD on
pages 41~42.

Select to send selected files to other

Send

devices.
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The Ripping function converts CD
audio to the mp3 format and saves the

Ripping converted files on a USB device or the
mobile device connected to the player.
See Ripping on page 42.

Information Select to see the (Contents) information.

Encoding Selgct to manage the text encoding
options.

Delete Select to delete a file from the device.

| NOTES |

» Depending on the disc or storage device, the Options
menu may differ or not be shown.

Repeating Tracks on an Audio CD

You can set the product to repeat tracks on an
audio CD (CD-DA/MP3).

1. On the Playback screen, use the AV <4 »
buttons to select & in the lower left corner

of the screen, and then press the [&) button.

2. Usethe AV to select the repeat mode you
want - Off, One Song, or All - and then
press the [&) button.

00:43 y
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Shuffling Tracks on an Audio CD

You can set the product to play tracks on an audio
CD (CD-DA/MP3) at random.

1. On the Playback screen, use the AV <4 »
buttons to select % in the lower left corner
of the screen, and then press the [&) button.

2. Usethe AV to set the Shuffle mode On or
Off, and then press the button.

Creating a Playlist from an Audio CD

1. With the Playback screen displayed, select
the Options button, and then press the
button. The Options menu appears.

2. Usethe AY buttons to select Play Selected,
and then press the [&) button. The Selection
Play screen appears.

3. Usethe AV buttons to select a track, and
then press the [B) button. A check appears
to the left of the track.

4. Repeat Step 3 to select and check additional
tracks.

5. Toremove a track from the list, move to the
track, and then press the button again.
The check on the track is removed.

6. When done, press the A'Y button to select
Play, and then press the [&) button. The
Music Playback screen reappears listing only
the tracks you checked. The selected tracks
play automatically.

| NOTES |

» You can create a playlist with up to 99 tracks on Audio
CDs (CD-DA).

» If you have created a playlist, Play Selected is replaced
by Edit Playlist on the Options menu.

» 0On the Selection Play screen, you can also choose Select
All, Clear All, and Cancel.
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Media Play

- Use Select All to select all tracks. This cancels
your individual track selections. When you press the
RETURN button on your remote control or select the
Play button, and then press the button, all tracks
will appear on the Music Playback screen, and the
product will begin to play all tracks from Track 001.

- Use Clear All to deselect all selected tracks at once.
Then, select individual tracks or use Select All to
select all the tracks, and then press the RETURN
button on your remote control. If you do not use Select
Al or select individual tracks, the Playlist will not
change.

- Cancel cancels any changes you made on the Play
Select screen. When you return to the Playback screen,
the Playlist will be unchanged.

Ripping

1. Insert a USB device into the USB jack on the
front of the product.

2. With the Playback screen displayed, select
the Options and then press the button.
The Options menu appears.

3. Usethe A Y buttons to select Ripping,
and then press the [&] button. The Ripping
screen appears.

4. Usethe AY buttons to select a track, and
then press the button. A check appears
to the left of the track.

5. Repeat Step 4 to select and check additional
tracks.

6. Toremove a track from the list, move to the
track, and then press the [&) button again.
The check on the track is removed.

7. When done, select the Rip button using the
AV buttons, and then press the [&] button.
The Rip pop-up appears.

8. Use the AY buttons to select the device to
store the ripped files to, and then press the
button.
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| NOTES |
» Do not disconnect the device while ripping is in progress.
9. If you want to cancel ripping, press the

button and then select Yes. Select No to
continue ripping.

10. When ripping is complete, the "Successfully
Ripped." message appears. Press the
button.

11. Press the RETURN button or select Cancel,
and then press the button to go back to
the Playback screen.

| NOTES |

» This function is not available with DTS Audio CD.

» This function may not be supported by some discs.

» Ripping encodes music to the .mp3 format at 192kbps.

» On the Ripping screen, you can also choose Select All
and Clear All.
- Use Select All to select all tracks and press the
button. This cancels your individual track selections.
- Use Clear All to deselect all selected tracks at once.

Playing Photo Contents

You can play photo contents located on a DVD,
USB, mobile device or PC.

Using the Tools Menu

During playback, press the TOOLS button. A
series of icons appears at the bottom of the
screen. The icons, which are shown from left to
right on the screen, are shown in the same order,
from top to bottom, in the table below.

Previous Select to move to the previous picture.
Next Select to move to the next picture.
Start / Stop '

Slide Show Select to play/pause the slide show.




y

s"d? I Select the Slide Show settings.
Settings

Select to enlarge the current picture.
Zoom )

(Enlarge up to 4 times)

Select to rotate the picture. (This will
Rotate rotate the picture either clockwise or

counter clockwise.)
Background Select to listen to music while viewing
Music a slide show.

Select the picture mode - Dynamic,
Settings Standard, Movie, or User - or display

information about the current picture.
I NOTES |
» Depending on the disc or storage device, the Tools menu

may differ or not be shown.

v

To enable the background music function, the photo file must

be in the same storage media as the music file.

However, the sound quality can be affected by the bit rate of
the MP3 file, the size of the photo, and the encoding method.

You can't enlarge the subtitle and PG graphic in the full

v

screen mode.

Using the View & Options Menus

Using the View Menu

On a file screen containing photo files, select the
View and press the (&) button.

Displays all the photo files on the media

e or storage device by title.
Groups all the the photo files on the
Date media or storage device by date. Click a
group to see the photos in that group.
Folder Displays all Fhe folders on the media or
storage device.
I NOTES |

» Depending on the disc or storage device, the View menu
may differ or not be shown.

Using the Options Menu

On a file screen containing photo files, select the
Options and press the [&) button.

Slide show

Starts the slide show. Shows all the
files in the current folder, one after
another. If you want to create a slide
show with a selected group of photos,
see Play Selected below.

Play Selected

Lets you create a playlist by selecting
specific photos to see. It works
essentially the same for all media.
See Creating a Playlist from an Audio
CD on pages 41~42 for instructions.

Send

Select to upload selected files to an
on-line site (Picasa, Facebook etc) or a
device. To use this function, you need
to establish an account with the on-line
site, and then log in using the Log In
function. See Using the Send Function
on page 44.

Delete

Select to delete the a file from the
device.

| NOTES |

» Depending on the disc or storage device, the Options
menu may differ or not be shown.
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Media Play

Using the Send Function

You can upload files to an on-line site (Picasa,
Facebook etc) or a device.

1. With the Photo Playback screen displayed,
select the Options button, and then press
the button. The Options menu appears.

2. Usethe A Y buttons to select Send, and
then press the [&) button. The Selection
screen appears.

3. Usethe A'Y buttons to select a picture, and
then press the button. A check appears
to the left of the picture.

4. Repeat Step 3 to select and check additional
pictures.

5. Toremove a picture from the list, move to the
picture, and then press the button again.
The check on the picture is removed.

6. When done, press the A'Y button to select
Send, and then press the button.
The Send pop-up appears listing the on-line
sites (Picassa, Facebook, etc.) or devices
that you can send the photos to.

7. Select a destination, and then press the
button.

8. If you are sending the photos to an on-line
site, the site starts. Log in and follow the
directions on the screen.

I NOTES |

» To send photos to an on-line site you must have an
account with that site.
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Network Services

You can enjoy various network services such as
streaming video or on-line apps by connecting the
player to your network.

To use network services, you must first:

1. Connect the player to the network.
(See page 18)

2. Configure the network settings.
(See pages 27~30)

Logging In to Your Samsung
Account

Before you access Movies & TV Shows or Apps,
we suggest you log in to your Samsung account.

| NOTES |

» If you do not have a Samsung account, follow the
directions in the Quick Startup Guide to create one.

To log in to your Samsung account, follow these

steps:

1. With the Home screen displayed, press the
RED (A) button. The Log In screen appears.

2. Select the Email field, and then press the
button. The keyboard pop-up appears.

3. Using the keyboard, enter your e-mail
address. When finished, select the Done
button, and then press the button. The
Log In screen re-appears.

4. Select the Password field, and then press the
button. The keyboard pop-up appears.

5. Using the keyboard, enter your password.
When finished, select the Done button, and
then press the button. The Log In screen
re-appears.

6. To make the log in process easier next time,
select Sign me in automatically, and then
press the [&) button.

7. Select Log In, and then press the button.
The player logs you in to your account. Your
account e-mail is displayed on the bottom left
of the screen.

| NOTES |

If you selected Sign me in automatically, the next time
you log in, the player will automatically enter your e-mail
and password. All you need to do is select Log In.

If your e-mail address and password are not displayed
when the Log In screen appears, select the button with
the down pointing arrow head next to the Email field, and
then press the button. A drop down list of all your
registered accounts will appear. Select your account,
and then press the button. The player will fill in the
e-mail and password fields.

If you press the RED (A) button after you have logged

in, the My Account pop-up appears. On the pop-up, you
can select Logout, Change account information, Link
Service Accounts, Remove Accounts from the Device,
and Deactivate Account.

To rent Films and purchase for-pay apps, you must have
a credit card registered in your account. If you haven't
registered a card, select Change account information.
On the Change Account information page, select
Register Card, press the button, and then follow the
directions on the screen.

Before Using Movies & TV Shows
or Apps

If you haven’t set up Smart Hub, when you use
Movies & TV Shows or Apps for the first time, the
player will ask you to perform the Smart Hub set
up procedure.

v

v

v

v
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Network Services

1. Onthe Home screen, select either Movies &
TV Shows or Apps, and then press the

Using Movies & TV Shows
button. If you have selected Apps, goto Step 4. You can download or stream for pay and free-of-
2. If you selected Movies & TV Shows, the charge fims and TV shows and view them on your

Smart Hub pop-up appears asking if you Tv.

want to set up Smart Hub. Select Yes, and
then press the button. The Welcome
screen appears.

Select Start, and then press the button.
The Smart Hub Terms & Conditions, Privacy
Policy screen appears.

On the Smart Hub Terms & Conditions,
Privacy Policy screen, you must review and
agree to both the Smart Hub Terms and
Conditions and the Privacy Policy to use
Smart Hub.

Scroll down, and then click the View details
buttons to review the full documents.

When done reading, scroll up to the first entry
field, and press the button to agree to
the Terms and Conditions and consent to the
Privacy Policy.

Press the » button twice to go to the
Supplemental Privacy Notices screen.

Click the View details button to view the
entire notice.

When done reading, scroll up to the top entry
field, and then press the button.

I NOTES |

» You do not need to consent to the Supplemental
Privacy Notice, but one or more Smart TV features or
functionalities may not be available if you do not.

10. Press the » button twice. The Setup

Complete screen appears. Press the
button.
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Movies & TV Shows

B
NN

On the Home screen, select Movies & TV
Shows, and then press the [&] button.

Select one of the Featured or Recommended
films, and then press the button. The
page for that movie appears.

OR
Use the ¥ button to go to the bottom of
the screen. Select Favourites, Featured,
Movies, TV Shows, or Purchased, and then
press the [&) button.
On the page that appears, use the AV <4 »
buttons to select a show or movie, and then
press the (&) button.
On the Movies and TV Show screen, you
can also select What’s New, Most Popular,
or Genres to see more available shows or
films. On the Genre screen, use the AV <4 »
buttons to select a Genre, and then press the
button.
To make a selection on a page displaying
Movies and TV Show, use the A Y < »
buttons to make a selection, and then press
the [&] button.



3. To watch a selection, select Watch now, and
then press the button. A selection screen
appears listing various locations from which
you can rent the film along with prices.

4. Select a location, and then press the
button. Follow the directions on the screen to
start the movie.

| NOTES |

» If you haven't logged into your Samsung account, the Log
In screen will appear after Step 3 and you will need to log
in.

If you don't have a credit card associated with your
Samsung account, after you log in, the Register Card
screen will appear. Follow the directions on the screen.
You must have a credit card registered to your account to
rent Films and to purchase for-pay apps.

Using Apps

You can download applications from the Internet,
and access various for pay or free-of-charge
application and view them on your TV. To access
some applications, you need to have a Samsung
account.

The Apps Screen at a Glance

v

_—— 1 @

Recommended : Displays recommended contents
managed by Samsung.

) My Apps : Displays your personal gallery of
applications modifiable on the More Apps screen.

More Apps : Select to access the More Apps

@ | screen where you can add to, modify, and delete

applications and see all downloaded applications.

Featured Applications : Use the A ¥ < » buttons

o to highlight the displayed Feature Application, and

then press the button. Information about the
featured application appears.

Downloading Applications

You can download for pay or free-of-charge
applications through Samsung Apps.

1.

On the Apps screen, select Samsung Apps,
and then press the [&] button. The Samsung
Apps screen appears.

Across the top of the screen, under What'’s
New, you'll see a series of new apps. Use
the < » buttons to scroll the list right or left,
and then select an app. Press the button
to see more information about the app. If the
app is free, select Download, and then press
the (&) button to download the app.

If it is a for pay app, select Buy, press the
button, and then follow the instructions
on the screen.

| NOTES |

»

v

v

To buy an app, you must be logged into your Samsung
account and have a credit card registered to the account.
Press the RED (A) button on your remote to log in.

If you haven't registered a card, after you log in, press the
RED (A) button again, and then select Change Account
Information in the pop-up that appears. On the Change
Account information page, select Register Card, press
the button, and then follow the directions on the
screen.

You can also access and download apps from the
categories listed on the left of the screen. For instructions,
see Step 4.
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After the app has downloaded, select Run,
and then press the button to run the app
now. To run the app later, press the RETURN
button. In either case, the icon for the app will
appear on the Apps screen.

To see additional apps, use the AV <4 »
buttons to move to the category list on the
left side of the screen.

Use the A'Y buttons to select a category.
Each time you move the highlight to another
category, a different set of applications
appears on the right.

Use the » button to move to the applications
and the A'Y «» buttons to move from app
to app.

To see more information about an app, select
it, and then press the button.

To download the app, follow the directions in
Steps 2 and 3.

Starting an Application

1.

Select Apps on the Home screen, and then
press the [&) button.
On the Apps screen, use the A'Y €4 » buttons

to select an app, and then press the
button. The app starts.

Using the More Apps Screen

o4 e View :Date Downloaded (=2 Options.

179

nnnnnn
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The More Apps Screen lists all the apps you have
downloaded and lets you:

Sort the apps on the More Apps screen by Date
downloaded, Recently opened, and Title.
Apply a number of Options Menu functions to
the apps listed in the My Apps section of the
Apps screen including updating apps, moving
apps into a folder, deleting the apps from My
Apps, and locking the apps.

Start apps.

Sorting the Apps

To sort the apps on the More Apps screen, follow
these steps:

1.

On the Home screen, select Apps, and then
press the [&) button.

On the Apps screen, use the ¥ button

to move to the More Apps hotspot at the
bottom of the page, and then press the
button.

On the More Apps screen, use the A »
buttons to move to View at the top of the
screen, and then press the button.

In the drop down that appears, select Date
Downloaded, Recently Opened, or Title,
and then press the button. The apps
on the More Apps screen are sorted by the
criteria you have chosen.

Using the Options Menu Functions

Lock/Unlock

Using the Lock/Unlock function and the Security
PIN, you can lock applications so they cannot
be started on either the Apps screen or the More
Apps screen. The default PIN is 0000.

1.

On the More Apps screen, use the A »
buttons to go to Options at the top of the
screen, and then press the button.



Select Lock/Unlock, and then press the
button.

When the Lock service appears, enter the
PIN using the number buttons on your remote
control.

To lock an application, select the application,
and then press the [&] button. A lock
appears on the app. Repeat to lock other,
individual apps.

To unlock a locked app, select the
application, and then press the button.

To lock all the apps at once, use the A »
buttons to select the Lock All button, and
then press the [&] button.

To unlock all the locked apps at once, use the
A » buttons to select the Unlock All button
and then press the button.

Press the RETURN button twice to return to
the Apps screen. Locked apps will display a
lock on the upper right side.

Edit My Apps

Edit My Apps lets you add apps to and delete
apps from My Apps. It also lets you change the
position of an app in My Apps.

Add an App to My Apps

1.

On the More Apps screen, use the A »
buttons to go to Options at the top of the
screen, and then press the button.

Select Edit My Apps, and then press the
button. The Edit My Apps screen appears.

Select a full colour app from the top row of
apps, and then press the button. The

full colour app icon appears in the My Apps
area below and the app icon in the top row is
grayed out.

| NOTES |
» Grayed out apps are already in My Apps.

4.

When you return to the Apps screen, the app
will appear in the My Apps area.

Delete an App from My Apps

1.

On the More Apps screen, use the A »
buttons to go to Options at the top of the
screen, and then press the button.
Select Edit My Apps, and then press the
button. The Edit My Apps screen appears.
Select the app you want to delete from My
Apps, press the button, and then press
the A'Y «» button in the direction of the X.
The Remove from My Apps pop-up appears.
Select Yes, and then press the button.
When you return to the Apps screen, the app
will have been removed from the My Apps
area.

Move an App in My Apps

1.

On the More Apps screen, use the A »
buttons to go to Options at the top of the
screen, and then press the button.

Select Edit My Apps, and then press the
button. The Edit My Apps screen appears.

Select the app you want to move in My Apps,
press the button, and then press the

A VY «» button to move the app icon in the
direction of one of the arrows (<, >, A, etc.)
that appears around the app icon. The app
icon moves in the direction you have chosen.

After you have placed the app icon where
you want, press the button.

When you return to the Apps screen, the
app will be positioned in the location you had
selected.
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Create Folder

Create Folder lets you create a folder on the More
Apps screen into which you can put apps.

1. On the More Apps screen, use the A >
buttons to go to Options at the top of the
screen, and then press the button.

2. Select Create Folder, and then press the
button. The Set Folder Name pop-up
appears.

3. Pressthe button. The keyboard appears.

4. Select the Clear button on the right side,
and then press the button to remove
Folder 1 from the entry field. Then, using the
keyboard, enter the name you want to apply
to the folder.

5.  When finished, select the Done button on the
right side, and then press the button.
The pop-up reappears.

6. Select OK, and then press the button.
The new folder appears in the list of apps on
the left side of the screen.

Move to Folder

Move to Folder lets you move apps to the folder of
your choice.

1. On the More Apps screen, use the A >
buttons to go to Options at the top of the
screen, and then press the button.

2. Select Move to Folder, and then press
the &) button. The Move to Folder screen
appears.

3. Usethe AV «» buttons to move to an app,
and then press the button to select the
app. A check appears in the upper left corner
of the app.

4. To deselect an app, press the button.
The check disappears.

5. Repeat Step 3 to select additional apps.

| 50 Eengiish

I NOTES |

» To select all the downloaded apps, select Select All at the
top right of the screen, and then press the button. To
deselect all the apps, select Deselect All at the top right
of the screen, and then press the button.

6. When done, select Select folder at the top
of the screen, and then press the button.
The Select folder pop-up appears.

7. Inthe Select folder pop-up, use the AY
buttons to select the folder you want to move
the apps you selected to and then press the
button.

8. The Apps Moved pop up appears. Press the
button.
9. To open a folder, use the A ¥ €4 » buttons to

highlight the folder, and then press the
button.

Rename Folder

Rename Folder lets you rename an existing folder.

1. On the More Apps screen, use the A »
buttons to go to Options at the top of the
screen, and then press the [&) button.

2. Select Rename Folder, and then press

the button. The Rename Folder screen
appears, and a folder is highlighted.

3. Userthe AY «» buttons to highlight a
folder of your choice, and then press the
button. The Rename pop-up appears.

Press the button. The keyboard appears.
Enter the new name for the folder. When
finished, select Done on the right side, and
then press the button. The Rename pop-
up reappears displaying the new name.

6. Select OK, and then press the (&) button.
The folder is renamed.

7. Select Close on the right side of the screen,
and then press the [&] button.



Delete

Delete lets you delete apps and folders from the
My Apps screen. If there are apps in a folder,

both the folder and the apps are deleted together.
Delete removes apps permanently. If you decide
you want to use an app you deleted, you will need
to download it again.

1. On the More Apps screen, use the A »
buttons to go to Options at the top of the
screen, and then press the button.

2. Select Delete, and then press the button.
The Delete screen appears.

3. Usethe AY «» buttons to move to an app,
or folder and then press the (&) button to
select. A check appears in the upper left
corner of the app or folder you selected.

4. To deselect an app, press the button.
The check disappears.

5. Repeat Step 3 to select additional apps or
folders.

| NOTES |

» To select all the downloaded apps, select Select All at the
top right of the screen, and then press the button. To
deselect all the apps, select Deselect All at the top right
of the screen, and then press the button.

6. After you have made all your selections,
select Delete at the top of the screen, and
then press the button. The Delete pop-
up appears.

7. Select Yes, and then press the button.
All the apps you selected are deleted.

| NOTES |

» You cannot immediately delete a locked app or folder.
If you select a locked app or folder to delete, when you
perform Step 7, the Lock Service pop-up appears. Enter
the Security PIN into the pop-up, and then press the
button. The lock will be released and the app or folder will
be deleted.

Update Apps

Update Apps automatically searches the Internet
for updated versions of the apps you have
downloaded and updates them if it finds newer
versions.

1. On the More Apps screen, use the A »
buttons to go to Options at the top of the
screen, and then press the button.

2. Select Update Apps, and then press the
button.

3. The unit searches the Internet for newer
versions of your apps. If there are new apps,
the Update Apps pop-up appears.

4. To download the update for a particular app,
highlight the app, and then press the
button. A check appears to the left of the
app.

5. To deselect the app, highlight it, and then
press the [&) button.

| NOTES |

» To select all the updates, select Select All on the right of
the pop-up, and then press the button. To deselect
all the updates, select Deselect All, and then press the
button.

6. After you have selected the updates you
want to download, select Update on the right
side of the pop-up, and then press the
button.

7. The unit downloads the updates you have
chosen. A download bar appears in each
app icon as the update for that app is
downloaded. The download is complete
when the download bars disappear.
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The Screen Mirroring function lets you view the
screen of your smart phone or android tablet on
the TV you have connected to the Blu-ray player.

1. With the Blu-ray's Home screen displayed,
press the BLUE (D) button on the remote.
The Screen Mirroring pop-up appears.

2. Launch AllShare Cast on your device.

3.  On your device, find the name of the Blu-ray
player in the list of available devices and then
select it.

4. The TV will display a PIN. Enter the PIN into
your device.

5. The TV displays a connecting message (for
example, Connecting to Android_92gb...) and
then displays the connected message.

6. In afew moments, the screen of your device
appears on the TV screen.

7. To stop Screen Mirroring, press the EXIT
or RETURN button on the remote control,
or disable Screen Mirroring function of your
smart phone.

I NOTES |

» You can connect to a device that supports AllShare Cast.
Note that connecting to such a device may not be fully
supported depending on the manufacturer. For further
information on mobile connection support, refer to the
manufacturer’s web site.

When you are using the Screen Mirroring function, video
stuttering or audio dropouts may occur, depending on
your environment.

Bluetooth transmissions can interfere with the Screen
Mirroring signal. Before using the Screen Mirroring
function, we strongly recommend that you turn off the
Bluetooth function on your smart phone or smart device
(tablet, etc.).

Screen Mirroring is only available with mobile devices
that support AllShare Cast or Wireless Mirroring. For
more information, visit the mobile device manufacturer's
website.

v

v

v
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Using the Web Browser

You can access the Internet using the Web
Browser application.

Select Web Browser on the Home screen, and
then press the [&] button.

| NOTES |

» When you run the Web Browser with the player connected
by HDMI to a BD Wise compatible TV - and BD Wise is on
- the browser is maximized to fill the screen and the TV's
resolution is set to the optimal resolution automatically.

The Web Browser is not compatible with Java
applications.

If you attempt to download a file, and the file cannot be
saved, an error message will appear.

E-commerce (purchasing products onling) is not
supported.

ActiveX is not supported.

Access may be blocked to some websites or to web
browsers operated by certain businesses.

v

v

v

v v

Link Browsing and Pointer Browsing

The Web Browser provides two types of browsing,
Pointer Browsing and Link Browsing. When you
launch the browser for the first time, Pointer
Browsing is active. If you are using a mouse to
navigate in the Web Browser, we recommend
leaving Pointer Browsing active. If you are using
your remote to navigate in the Web Browser, we
recommend that you replace Pointer Browsing
with Link Browsing. Link Browsing moves a
highlight from one link to the next in the Web
Browser and is much faster than Pointer Browsing
if you are using your remote.

To activate Link Browsing, follow these steps:

1. Usethe A'Y «» buttons on your remote to

move the pointer to the Link Browser icon on
the top right of the screen. The Link Browser
icon is the third icon from the right.
The pointer will be in the correct position
if the icon turns blue and the words “Link
Browsing” appear on the screen.

2. Press the (&) button. Link Browsing is

activated and will remain active whenever you
bring up the Web Browser.



The Control Panel at a Glance

The Control Panel, which runs across the top

of the screen, has a series of icons which start

a number of useful functions. The icons are
described below, starting with the icon on the far
left of the screen.

AN - Mo samsing com 7% O 0% ) ()

I

e 2 : Moves to the previous page.

o =2 : Moves to the next web page.

|4 : Displays the Bookmarks and History screen.

You can bookmark the current page, select

an existing bookmark, and edit and delete

bookmarks. You can also view your browsing

history and select a page to revisit.

[ - Moves to the Home screen of the Web

Browser.

- Lets you enter a page

address manually using the keyboard pop-up.

53 : Reloads the current page so that it is

(1) refreshed on the screen.

|4 : Adds the current page to your bookmarks.

[ ]:Lets you search for information

by entering words or characters using the

keyboard pop-up. See Using the Keyboard Pop-

up on page 53.

- Lets you enlarge or shrink the screen

by various percentages.

15 : Lets you switch between Pointer Browsing

and Link Browsing.

o 3 Lets you configure the Browser’s settings.
See Using the Settings Menu on page 54.

o 3 : Closes the Web Browser.

L]

Using the Keyboard Pop-up

When you click the [ ntipzwwwsamsingeom |, the
[ Joraccess a data or text entry field,
and then press the button, the keyboard pop-
up appears.

To use the keyboard pop-up with your remote,
follow these steps:

1. Use the A Y «» buttons on your remote to
move the highlight to a letter or number of
your choice.

2. Press the [E] button to enter the letter or
number into the entry field.

3. To access capital letters, move the highlight
to the Caps key on the top left, and then
press the [&) button. Press the [&] button
again with the Caps key highlighted to
access small letters again.

4. To access symbols and additional punctuation
marks, highlight the 123#& button on the left,
and then press the button.

5. To delete a character you entered, move the
highlight to the « button, and then press the
button.

6. To delete all the characters you entered,
move the highlight to the Clear button, and
then press the [&] button.

7. When finished entering, move the highlight
to the Done button, and then press the
button.
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I NOTES |

» If you have a wireless keyboard connected to your
player, you can use the wireless keyboard to enter
letters, numbers, symbols, and punctuation. Note that
the wireless keyboard will work only when the keyboard
popup appears and can only be used to enter letters,
numbers, symbols, and punctuation.

Options on the Keyboard Pop-Up

To access the keyboard pop-up options, highlight
the [} button on the bottom left of the keyboard,
and then press the button.

Enable/Disable
Grabbing

Turns the Grabber function on and off.
When the Grabber function is on, you
can move a web page up and down
without dragging the scroll bar.

The Grabber function is only available
in Pointer Browsing.

Select the language for the keyboard.
You can select English, French,
Russian, etc.

Language

The keyboard will suggest
recommended words as you enter text.
You can turn this function On or Off.

Recommended
Text

The keyboard will predict the next letter
as you enter letters. The predictions
appear in a ring around the letter you
have just entered. You can select a
predicted letter or move to another
letter. You can turn this function On or
Off.

Predict Next
Letter

Using the Setting Menu

The Setting menu contains functions that control
how the Browser operates and Browser security
functions. To open the Setting menu, highlight

the k.4 icon in the Control Panel, and then press
the button. To select an option in the setting
menu, highlight the option, and then press the
button.

GOl

Enable Grabbing
Approved Sites
Private browsing On
Web Browser Settings

Help
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Approved Sites

Lets you restrict your children’s access
to inappropriate web pages by allowing
access only to the web sites you have
registered.

Every time you access this function, the
PIN screen appears. The first time you
access this function, enter the default
PIN, 0000 using the number buttons
on your remote.

You can change the PIN using the
Reset password for the Approved Sites
function. See below.

Approved Sites Feature : Turns the
Approved Sites function on or off.
Reset password for Approved Sites :
Change the Approved Sites password.
Add current site : Lets you add the
currently displayed web site to the
Approved Sites list.

Manage Approved Sites : Lets you
key in URLs to add to the Approved
Sites List and delete sites from the
Approved Sites list.

If you turn this function on and have
not added any sites to the Approved
Sites list, you will not be able to access
any Internet sites.




Private
Browsing On/Off

Enable or disable the Privacy mode.
When the Privacy mode is enabled,
the browser does not retain the URLsS
of sites you visit. If you want to enable
Privacy mode, select OK.

If the Privacy mode is running, the
“Stop” icon appears in front of the URL
at the top of the screen. To disable
Privacy mode, select it again when
Privacy mode is enabled.

Web Browser
Setting

Set as homepage : You can set the
Browser's home page.

Pop-up Block : Turns the Popup Block
on and off.

Ad Block : You can determine whether
to block advertisements and select the
URLs for which advertisements are
blocked.

General : You can delete personal
information such as website history
and browsing data (cookies, etc.), and
reset all web browser settings to their
factory defaults.

Encoding : You can set the Encoding
setting for web pages to Automatic or
select the encoding format manually
from a list.

Pointer : You can set the speed of the
cursor when the cursor is set to Pointer
and turn Smart Cursor On and Off.
Browser Information : Displays

the version number and copyright
information for the Web Browser.

Help

Provides basic information about the
operation of the Web Browser.

| NOTES |

» Depending on the web site, some of the Web Browser
Setting functions may not be activated. Functions that are
not activated are greyed out and cannot be used.

Linking Your Internet Ser

Accounts to the Player

The Link Service Accounts function lets you link
your player to your accounts with Internet services
such as Pandora so that the player can log you

in to the service automatically when you start the
app for that service.

To create a service account link, follow these
steps:

1. On the Home screen, press the RED (A)
button on your remote to log in to your
Samsung Account.

2. After you have logged in, press the RED (A)
button on your remote again.

3. Select Link Service Accounts in the My
Account pop-up, and then press the
button.

4. On the Link Service Accounts screen, select
the service you want to link to the player, and
then press the [&] button.

5. Select Register, and then press the
button.

6. Inthe ID and Password screen, enter the ID
you use to log in to the service you selected
using the pop-up keyboard. When finished,
select Done, and then press the [&) button.

7. Repeat the same process for the password.
When finished select Done, and then press
the (&) button.

8. Select OK, and then press the button.
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Once the player is connected to your network, you
can enjoy various movie-related service contents
available on BD-LIVE compliant discs.

1. Attach a USB flash memory drive to the
USB jack on the front of the player, and then
check its remaining memory. The memory
device must have at least 1GB of free space
to accommodate the BD-LIVE services.

2. Select Settings on the Home screen, and
then press the [&] button.

3. Select Network, and then press the
button.

4. Select BD-Live Settings, and then press the
button.

5. Select BD Data Management, and then
press the [&) button.

6. Select Select Device, and then press the
button.

7. Select USB device, and then press the
button.

8. Insert a Blu-ray Disc that supports BD-LIVE.

9. Select an item from the list of BD-LIVE service
contents provided by the disc manufacturer.

I NOTES |

» The way you use BD-LIVE and the provided contents may
differ, depending on the disc manufacturer.
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Appendix
Compliance and Compatibility Notice

NOT ALL discs are compatible

® Subject to the restrictions described below and those noted throughout this Manual, including the Disc

Type and Characteristics section of this user manual, disc types that can be played are: pre-recorded

commercial BD-ROM, DVD-VIDEO, and Audio CD (CD-DA); BD-RE/-R, DVD-RW/-R; and CD-RW/-R.

Discs other than the above cannot and/or are not intended to be played by this player. And some of

the above discs may not play due to one or more reasons provided below.

e Samsung cannot assure that this player will play every disc bearing the BD-ROM, BD-RE/-R,
DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and CD-RW/-R logos, and this player may not respond to
all operating commands or operate all features of every disc. These and other disc compatibility and
player operation issues with new and existing format discs are possible because:

- Blu-ray is a new and evolving format and this player may not operate all features of Blu-ray Discs
because some features may be optional, additional features may have been added to the Blu-ray
Disc format after the production of this player, and certain available features may be subject to
delayed availability;
not all new and existing disc format versions are supported by this player;

- new and existing disc formats may be revised, changed, updated, improved and/or supplemented;

some discs are produced in a manner that allows specific or limited operation and feature during

playback;

some features may be optional, additional features may have been added after the production of this

player or certain available features may be subject to delayed availability;

some discs bearing the BD-ROM, BD-RE/-R, DVD-VIDEO, DVD-RW/-R, DVD+RW/+R and

CD-RW/-R logos may still be non-standardized discs;

- some discs may not be played depending on their physical state or recording conditions;

problems and errors can occur during the creation of Blu-ray Disc, DVD software and/or the

manufacture of discs;

- this player operates differently than a standard DVD player or other AV equipment; and/or

for reasons noted throughout this user manual and for other reason(s) discovered and posted by

SAMSUNG customer care centre.

If you encounter disc compatibility or player operation problems, please contact SAMSUNG customer

care centre.

You may also contact SAMSUNG customer care centre for possible updates on this player.

For additional information on playback restrictions and disc compatibility, refer to the Precautions,

Before Reading the user manual, Disc Types and Characteristics, and Before Playing sections of this

user manual.

For Blu-ray Disc Player progressive scan output : CONSUMERS SHOULD NOTE THAT NOT

ALL HIGH DEFINITION TELEVISION SETS ARE FULLY COMPATIBLE WITH THIS PRODUCT AND

MAY CAUSE ARTIFACTS TO BE DISPLAYED IN THE PICTURE. IN CASE OF PROGRESSIVE SCAN

PICTURE PROBLEMS, IT IS RECOMMENDED THAT THE USER SWITCH THE CONNECTION TO

THE 'STANDARD DEFINITION' OUTPUT. IF THERE ARE QUESTIONS REGARDING OUR TV SET

COMPATIBILITY WITH THIS PRODUCT, PLEASE CONTACT OUR CUSTOMER SERVICE CENTRE.

[ ]
xipusddy 20 |
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Because AACS (Advanced Access Content System) is approved as content protection system for
Blu-ray Disc format, similar to use of CSS (Content Scramble System) for DVD format, certain
restrictions are imposed on playback, analogue signal output, etc., of AACS protected contents.

The operation of this product and restrictions on this product may vary depending on your time of
purchase as those restrictions may be adopted and/or changed by AACS after the production of this
product. Furthermore, BD-ROM Mark and BD+ are additionally used as content protection system for
Blu-ray Disc format, which imposes certain restrictions including playback restrictions for BD-ROM
Mark and/or BD+ protected contents. To obtain additional information on AACS, BD-ROM Mark, BD+,
or this product, please contact SAMSUNG customer care centre.

Many Blu-ray Disc/DVDs are encoded with copy protection. Because of this, you should only connect
your Player directly to your TV, not to a VCR. Connecting to a VCR results in a distorted picture from
copy-protected Blu-ray Disc/DVDs.

Under the U.S. Copyright laws and Copyright laws of other countries, unauthorised recording, use,
display, distribution, or revision of television programs, videotapes, Blu-ray Discs, DVDs, and other
materials may subject you to civil and/or criminal liability.

Cinavia Notice : This product uses Cinavia technology to limit the use of unauthorised copies of
some commercially-produced film and videos and their soundtracks. When a prohibited use of

an unauthorised copy is detected, a message will be displayed and playback or copying will be
interrupted.

More information about Cinavia technology is provided at the Cinavia Online Consumer Information
Centre at http://www.cinavia.com. To request additional information about Cinavia by mail, send a
postcard with your mailing address to: Cinavia Consumer Information Centre, P.O. Box 86851, San
Diego, CA, 92138, USA.

This product incorporates proprietary technology under licence from Verance Corporation and is
protected by U.S. Patent 7,369,677 and other U.S. and worldwide patents issued and pending as well
as copyright and trade secret protection for certain aspects of such technology. Cinavia is a trademark
of Verance Corporation. Copyright 2004-2010 Verance Corporation. All rights reserved by Verance.
Reverse engineering or disassembly is prohibited.

Network Service Disclaimer

All content and services accessible through this device belong to third parties and are protected by
copyright, patent, trademark and/or other intellectual property laws. Such content and services are
provided solely for your personal noncommercial use. You may not use any content or services in a
manner that has not been authorised by the content owner or service provider. Without limiting the
foregoing, unless expressly authorised by the applicable content owner or service provider, you may
not modify, copy, republish, upload, post, transmit, translate, sell, create derivative works, exploit, or
distribute in any manner or medium any content or services displayed through this device.
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THIRD PARTY CONTENT AND SERVICES ARE PROVIDED "AS IS." SAMSUNG DOES NOT WARRANT
CONTENT OR SERVICES SO PROVIDED, EITHER EXPRESSLY OR IMPLIEDLY, FOR ANY PURPOSE.
SAMSUNG EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES, INCLUDING BUT NOT LIMITED
TO, WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SAMSUNG
DOES NOT GUARANTEE THE ACCURACY, VALIDITY, TIMELINESS, LEGALITY, OR COMPLETENESS
OF ANY CONTENT OR SERVICE MADE AVAILABLE THROUGH THIS DEVICE AND UNDER NO
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL SAMSUNG BE LIABLE, WHETHER IN
CONTRACT OR TORT, FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL OR CONSEQUENTIAL
DAMAGES, ATTORNEY FEES, EXPENSES, OR ANY OTHER DAMAGES ARISING OUT OF, OR IN
CONNECTION WITH, ANY INFORMATION CONTAINED IN, OR AS A RESULT OF THE USE OF ANY
CONTENT OR SERVICE BY YOU OR ANY THIRD PARTY, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.

Third party services may be terminated or interrupted at any time, and Samsung makes no representation
or warranty that any content or service will remain available for any period of time. Content and services
are transmitted by third parties by means of networks and transmission facilities over which Samsung
has no control. Without limiting the generality of this disclaimer, Samsung expressly disclaims any
responsibility or liability for any interruption or suspension of any content or service made available
through this device.

Samsung is neither responsible nor liable for customer service related to the content and services.

Any question or request for service relating to the content or services should be made directly to the
respective content and service providers.

Licence

* Manufactured under licence from Dolby Laboratories. Dolby and the double-D symbol  [Y] DOLBY.
are registered trademarks of Dolby Laboratories. " TRUELL |
DIGITAL PLUS
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e Manufactured under license under U.S. Patent Nos: 5,956,674; 5,974,380; =dtsup
6,226,616; 6,487,535; 7,212,872; 7,333,929; 7,392,195; 7,272,567 & other U.S. Master Audio
and worldwide patents issued & pending. DTS-HD, the Symbol, & DTS-HD and the
Symbol together are registered trademarks & DTS-HD Master Audio is a trademark of
DTS, Inc. Product includes software. © DTS, Inc. All Rights Reserved.

* DX DIVX
HD h

- ABOUT DIVX VIDEO: DivX® is a digital video format created by DivX, LLC, a
subsidiary of Rovi Corporation. This is an official DivX Certified® device that plays
DivX video. Visit divx.com for more information and software tools to convert your files into DivX
videos.
- ABOUT DIVX VIDEO-ON-DEMAND: This DivX Certified® device must be registered in order to
play purchased DivX Video-on-Demand (VOD) movies. To obtain your registration code, locate the
DivX VOD section in your device setup menu. Go to vod.divx.com for more information on how to
complete your registration.
DivX Certified® to play DivX® video up to HD 1080p, including premium content.
DivX®, DivX Certified® and associated logos are trademarks of Rovi Corporation or its subsidiaries
and are used under licence.
Covered by one or more of the following U.S. patents : 7,295,673; 7,460,668; 7,515,710; 7,519,274.
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¢ The terms HDMI and HDMI High-Definition Multimedia Interface, and the HDMI Hnml
Logo are trademarks or registered trademarks of HDMI Licensing LLC in the United
States and other countries.

¢ Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names (
may be trademarks of their respective owners. Q{)
<
Java-

POWERED
e Open Source Licence Notice

- In the case of using open source software, Open Source Licences are available on the product
menu.

e Blu-ray Disc™, Blu-ray™ and the logos are trademarks of the Blu-ray Disc Association.

Recommendation - EU Only

essential requirements and other relevant provisions of Directive 1999/5/EC.

The official Declaration of Conformity may be found at http://www.samsung.com,
go to Support > Search Product Support and enter the model name.

This equipment may be operated in all EU countries.

This equipment may only be used indoors.

e Hereby, Samsung Electronics, declares that this BD Player is in compliance with the C € @
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Additional Information
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Notes

3D Settings

e For some 3D discs, to stop a movie during 3D playback, press the [E3 (STOP) button once. The
movie stops and the 3D mode option is de-activated.
To change a 3D option selection when you are playing a 3D movie, press the [C3 (STOP) button
once. The Blu-ray menu appears. Press the [ (STOP) button again, then select 3D Settings in
the Blu-ray menu.

e Depending on the content and the position of the picture on your TV screen, you may see vertical
black bars on the left side, right side, or both sides.

TV Aspect Ratio

e Depending on the disc type, some aspect ratios may not be available.

e |f you select an aspect ratio and option that is different than the aspect ratio of your TV screen,
the picture might appear to be distorted.

o |f you select the 16:9 Original, your TV may display 4:3 Pillarbox (black bars on sides of picture).

BD Wise (Samsung Players only)

o \When BD Wise is on, the Resolution setting automatically defaults to BD Wise and BD Wise
appears in the Resolution menu.

o |f the player is connected to a device that does not support BD Wise, you can not use the BD
Wise function.

Settings o For proper operation of BD Wise, set the BD Wise option of both the player and the TV to On.

Digital Output

e Be sure to select the correct Digital Output or you will hear no sound or just loud noise.

o |f the HDMI device (AV receiver, TV) is not compatible with compressed formats (Dolby Digital,
DTS), the audio signal outputs as PCM.

e Regular DVDs do not have BONUSVIEW audio and Navigation Sound Effects.

e Some Blu-ray Discs do not have BONUSVIEW audio and Navigation Sound Effects.

e This Digital Output setup does not affect the HDMI audio output to your TV.
It affects the optical and HDMI audio output when your player is connected to an AV receiver.

e |f you play MPEG audio soundtracks, the audio signal outputs as PCM regardless of your Digital
Output selections (PCM or Bitstream).

PCM Downsampling

e Even when PCM Downsampling is set to Off, some discs will only output downsampled audio
through the optical digital output.
o HOMI
- If your TV is not compatible with compressed multi-channel formats (Dolby Digital, DTS), the
player may output PCM 2ch downmixed audio even though you selected Bitstream (either
Reencoded or Unprocessed) in the setup menu.
- If your TV is not compatible with PCM sampling rates over 48kHz, the player may output
48kHz.
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Settings

BD-LIVE Internet Connection

e What is a valid certificate?
When the player uses BD-LIVE to send the disc data and a request to the server to certify the
disc, the server uses the transmitted data to check if the disc is valid and sends the certificate
back to the player.

o The Internet connection may be restricted while you are using BD-LIVE contents.

BD Data Management

 |n the external memory mode, disc playback may be stopped if you disconnect the USB device in
the middle of playback.

o Only those USB devices formatted in the FAT file system (DOS 8.3 volume label) are supported.
We recommend you use USB devices that support USB 2.0 protocol with 4 MB/sec or faster
read/write speed.

o The Resume Play function may not work after you format the storage device.

o The total memory available to BD Data Management may differ, depending on conditions.

Anynet+ (HDMI-CEC)

e Depending on your TV, certain HDMI output resolutions may not work. Please refer to the user
manual of your TV.

o This function is not available if the HDMI cable does not support CEC.
e |f your Samsung TV has an Anynet+ logo, then it supports the Anynet+ function.

Media Play

Selecting the Audio Language

e The <« » indicator will not appear on the screen if the BONUSVIEW section does not contain any
BONUSVIEW audio settings.

o The languages available through the Audio Language function depend on the languages that are
encoded on the disc. This function or certain languages may not be available.

o Some Blu-ray Discs may allow you to select either the PCM or Dolby Digital audio soundtrack in
English.

Selecting the Subtitle Language

o Depending on the Blu-ray Disc / DVD, you may be able to change the subtitle language in the
Disc Menu. Press the DISC MENU button.

o This function depends on the selection of subtitles that are encoded on the disc and may not be
available on all Blu-ray Discs/DVDs.

o |nformation about the main feature BONUSVIEW mode will also appear if the Blu-ray Disc has a
BONUSVIEW section.

o This function changes both the primary and secondary subtitles at the same time.
o The total number of primary and secondary subtitles are displayed respectively.

o |f you press the SUBTITLE button on the remote control, the subtitle bar appears.
Press the RETURN button to remove the subtitle bar.
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Resolution according to the contents type

—
Setup comens e R Di:i-tilll)[::t::tt:r/ns S
BD Wise Resolution of Blu-ray Disc 1080p §
Movie Frame : Auto 1080p@24F 1080p@24F g__
Ao Movie Frame : Off Max. Resolution of TV input Max. Resolution of TV input =
Movie Frame : Auto (24Fs) 1080p@24F 1080p@24F
1080p (Movie Frame : Off) 1080p 1080p
1080i 1080i 1080i
720p 720p 720p
576p/480p 576p/480p 576p/480p
Sotup Contents Type DVD
BD Wise 576i/480i
) DVD 24Fs Conversion : Auto 1080p@24F
Auto Voie Frame - Auto DVD 24Fs Conversion : Off Max. Resolution of TV input
Movie Frame : Off Max. Resolution of TV input
1080p 1080p
1080i 1080i
720p 720p
576p/480p 576p/480p
| NOTES |

» |f the TV you connected to the player does not support Movie Frame or the resolution you selected, the message "/f no
pictures are shown after selecting 'Yes', please wait for 15 seconds to return to the previous resolution. Do you want to
change the resolution?" appears. If you select Yes, the TV's screen will go blank for 15 seconds, and then the resolution will
revert to the previous resolution automatically.

v

If the screen stays blank after you have changed the resolution, remove all discs, and then press and hold the H button

on the top of the player for more than 5 seconds. All settings are restored to the factory default. Run the Initial Settings
procedure again. Then, go to Settings > Display > Resolution in the Menu, and select the correct resolution for your TV.

v

When you run the Initial Settings procedure, re-select the language and aspect ratio (screen size and format) only. Resetting

does not affect your network settings, so you should be able to skip Network Setup and Software Update.

v v

When the factory default settings are restored, all stored user BD data will be deleted.
The Blu-ray Disc must have the 24 frame feature for the player to use the Movie Frame (24Fs) mode.
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Digital Output Selection

Bitstream Bitstream Bitstream
Setup PCM (Unprocessed) (Re-encoded | (Re-encoded
P DTS) Dolby D)
HDMI HDMI su H(?rthgld AV HDMI supported
Connection supported | Optical | supported | Optical pp . AV receiver or
. . receiver or .
AV receiver AV receiver . Optical
Optical
pem | UOPOM Fpomacn | pom | poMzch | DTS re-encoded| Fe-encoded
7.1¢ch Dolby Digital
. Up to PCM o . Re-encoded
Dolby Digital 7 1ch PCM 2ch | Dolby Digital | Dolby Digital | DTS re-encoded Dolby Digital
Dolby Digital | Up to PCM Dolby Digital - . Re-encoded
Plus 71¢ch PCM 2ch Plus Dolby Digital | DTS re-encoded Dolby Digital *
Audio Stream Up to PCM - Re-encoded
on Blu-ray Dolby TrugHD 7 1¢ch PCM 2ch |Dolby TrueHD | Dolby Digital | DTS re-encoded Dolby Digital
Disc U
p to PCM ’ Re-encoded
DTS 6.1ch PCM 2ch DTS DTS DTS re-encoded Dolby Digital *
DTS-HD High DTS-HD High
Resolution Up7t (; EhC M PCM 2ch | Resolution DTS DTS re-encoded Di?[;ergoﬂg?*
Audio : Audio yoe
DTS-HD Up to PCM DTS-HD Re-encoded
Master Audio 7.1¢ch PCM 2ch Master Audio DTS DTS re-encoded Dolby Digital *
PCM PCM2ch | PCM2ch | PCM 2ch PCM 2ch PCM 2ch PCM 2ch
Audio Stream | Dolby Digital Up;(; (F:’hC M PCM 2ch | Dolby Digital | Dolby Digital | ~ Dolby Digital Dolby Digital
on DVD -
ors | P pomacn [ ots DTS DTS DTS
Decodes the main| Decodes the main
feature audio | feature audio and
Outputs only the main | and BONUSVIEW | BONUSVIEW audio
Decodes the main feature |feature audio stream so that| audio stream stream together
Definition for audio and BONUSVIEW  Jyour AV receiver can decodetogether into PCM into PCM audio and
Blu-ray Disc Any audio stream together the audio bitstream. audio and adds | adds Navigation
y into PCM audio and adds You will not hear Navigation Sound | ~ Sound Effects,
Navigation Sound Effects. BONUSVIEW audio or Effects, then re- | then re-encodes
Navigation Sound Effects. |encodes the PCM| the PCM audio
audio into DTS | into Dolby Digital
bitstream. bitstream or PCM.

* If the Source Stream is 2¢h or mono, "Re-encoded Dolby D" Settings are not applied. Output will be

PCM 2ch.

Blu-ray Discs may include three audio streams :
- Main Feature Audio : The audio soundtrack of the main feature.
- BONUSVIEW audio : An additional soundtrack such as the director or actor's commentary.

- Navigation Sound Effects : When you choose some menu navigation, Navigation Sound Effects may
sound. Navigation Sound Effects are different on each Blu-ray Disc.
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Troubleshooting

Before requesting service, please try the following solutions.

PROBLEM

SOLUTION

No operation can be performed with the
remote control.

e Check the batteries in the remote control. They may need replacing.

e (Operate the remote control at a distance of no more than 6.1m from the
player.

e Remove the batteries and hold down one or more buttons for several
minutes to drain the microprocessor inside the remote control to reset it.
Reinstall the batteries and try to operate the remote control again.

The disc does not play.

e Ensure that the disc is installed with the label side facing up.
o (heck the region number of the Blu-ray Disc/DVD.

The disc Menu does not appear.

e Ensure that the disc has disc menus.

The prohibition message appears on the
screen.

o This message appears when an invalid button is pressed.

o The Blu-ray Disc/DVD's software doesn't support the feature (e.g., angles).

* You've requested a title or chapter number or search time that is out of
range.

Play mode differs from the Setup Menu
selection.

o Some of the functions selected in the Setup Menu may not work properly if
the disc is not encoded with the corresponding function.

The screen ratio cannot be changed.

o The Screen Ratio is fixed on your Blu-ray Disc/DVD.
o This is not a problem with the player.

No audio.

o Make sure you have selected the correct Digital Output in the Audio Options
Menu.

The screen is blank.

o |f the HDMI output is set to a resolution your TV cannot support (for
example, 1080p), you may not see a picture on your TV.

o Press the M button (on top panel) for more than 5 seconds with no disc
inside. All settings will revert to the factory settings.

o When the factory default settings are restored, all stored user BD data will
be deleted.

Forgot password.

e Press the M button (on top panel) for more than 5 seconds with no disc
inside. All settings including the password will revert to the factory settings.
Don't use this unless absolutely necessary.

e \When the factory default settings are restored, all stored user BD data will
be deleted.
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PROBLEM

SOLUTION

The picture is noisy or distorted.

o Make sure that the disc is not dirty or scratched.
e (Clean the disc.

No HDMI output.

o (heck the connection between the TV and the HDMI jack of the player.
o (Check if your TV supports the 576p/480p, 720p, 1080i or 1080p HDMI
input resolution.

Abnormal HDMI output screen.

e |f random noise appears on the screen, it means that TV does not support
HDCP (High-bandwidth Digital Content Protection).

If you experience other problems.

e (o to the table of contents and find the section of the user manual that
contains information about the feature you are having the problem with,
and then follow the procedure again.

o |f you still cannot resolve the problem, please contact your nearest
Samsung authorised service centre.

AllShare function

| can see folders shared through AllShare,
but | cannot see the files.

o AliShare only shows Video, Photo, and Music files. Other types of files are
not displayed.

The video plays intermittently.

o Check if the network is stable.

o Check if the network cable is properly connected and if the network is not
overloaded.

o The wireless connection between the AllShare compatible device and the
player is unstable.
Check the connection.

The AllShare connection between the player
and the PC is unstable.

o |P addresses within the same subnetwork should be unique.
If they are not, IP interference can cause this phenomenon.
o Check if you have a firewall enabled.
If so, disable the firewall function.
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PROBLEM SOLUTION
BD-LIVE
| cannot connect to the BD-LIVE server. o Test whether the network connection is working using the Network Status

function. (See page 22)
o (Check whether a USB memory device is connected to the player.
e The memory device must have at least 1GB of free space to accommodate

the BD-LIVE service.
You can check the available size in BD Data Management. (See page 23)

o See if the BD-LIVE Internet Connection option is set to Allow(All).
o [f all above fails, contact the contents provider or update to the player to the
atest firmware.

xipusddy 20 |

When using the BD-LIVE service, an error e The memory device must have at least 1GB of free space to accommodate
0cCurs. the BD-LIVE service.
You can check the available size in BD Data Management. (See page 23)

| NOTES |
» When the factory default settings are restored, all stored user BD data will be deleted.

Repairs

If you contact us to repair your player, an administration fee may be charged if either:

1. Anengineer is called out to your home at your request and there is no defect in the product.
2. You bring the unit to a repair centre and there is no defect in the product.

We will provide you with the amount of the administration fee before we make a home visit or begin any

work on your player.
We recommend you read this manually thoroughly, search for a solution on line at www.samsung.com, or

contact Samsung Customer Care before seeking to repair your player.
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Specifications

Weight 1.2Kg
General Dimensions 360 (W) X 196 (D) X 39 (H) mm
Operating Temperature Range +5°C to +35°C
Operating Humidity Range 10 % t0 75 %
USB Type A USB 2.0
DC output 5V 500mA Max.
Video 2D : 1080p, 1080i, 720p, 576p/480p
HDMI 3D : 1080p, 720p
Audio PCM, Bitstream
Audio Output Digital Audio Output Optical
Ethernet 100BASE - TX Terminal
Wireless LAN Built-in
WEP (OPEN/SHARED)
Network — ecuriy WPA-PSK (TKIP/AES)
WPA2-PSK (TKIP/AES)
WPS(PBC) Supported

e Network speeds equal to or below 10Mbps are not supported.
e Design and specifications are subject to change without prior notice.
e For the power supply and power consumption, refer to the label attached to the player.

¢ Weight and dimensions are approximate.
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% UNITED KINGDOM
Z 1N

This Samsung product is warranted for the period of

twelve (12) months from the original date of
purchase, against defective materials and
workmanship. In the event that warranty service is
required, you should return the product to the
retailer from whom it was purchased.

However, Samsung Authorised Dealers and
Authorised Service Centres in other EC Countries
will comply with the warranty on the terms issued to
purchasers in the country concerned.

In case of difficulty, details of our Authorised Service
Centres are available from:

Customer Support Centre, PO Box 479,
Gatehead, Ne9 9BJ

United Kingdom
Tel: 0330 SAMSUNG (7267864)
Fax: 033 07260001
www.samsung.com/uk

Eire
Tel: 0818 717100
Fax: +44(0)117 915 6736
www.samsung.com/ie

B WARRANTY CONDITIONS

1. The warranty is only valid if, when warranty
service is required, the warranty card is fully and
properly completed and is presented with the
original invoice or sales slip or confirmation, and
the serial number on the product has not been
defaced.

2. Samsung's obligations are limited to the repair or,
at its discretion, replacement of the product or
the defective part.

3. Warranty repairs must be carried out by
Authorised Samsung Dealers or Authorised
Service Centres.

No re-imbursement will be made for repairs
carried out by non Samsung Dealers and, any
such repair work and damage to the products
caused by such repair work will not be covered
by this warranty.

EIRE

4. This product is not considered to be defective in
materials nor workmanship by reason that it
requires adaptation in order to conform to
national or local technical or safety standards in
force in any Country other than the one for which
the product was originally designed and
manufactured. This warranty will not cover, and
no re-imbursement will be made for such
adaptation nor any damage which may result.

5. This warranty covers none of the following:

a) Periodic check ups, maintenance and repair or
replacement of parts due to normal wear and
tear.

b) Cost relating to transport, removal or installation
of the product.

¢) Misuse, including the faiure to use this product
for its normal purposes or incorrect installation.

d) Damage caused by Lightning, Water, Fire, Acts
of God, War, Public Disturbances, incorrect
mains voltage, improper ventilation or any
other cause beyond the control of Samsung.

6. This warranty is valid for any person who legally
acquired possession of the product during the
warranty period.

7. The consumers statutory rights in any applicable
national legislation whether against the retailer
arising from the purchase contract or otherwise
are not affected by this warranty. Unless there is
national legislation to the contrary, the rights
under this warranty are the consumers sole rights
and Samsung, its subsidiaries and distributors
shall not be liable for indirect or consequential
loss or any damage to records, compact discs,
videos or audio taper or any other related
equipment or material.

SAMSUNG ELECTRONICS (U.K.) LTD.



Contact SAMSUNG WORLD WIDE
If you have any questions or comments relating to Samsung products, please contact the SAMSUNG customer

care centre.

Area Contact Centre & Web Site Area Contact Centre & Web Site
ALBANIA 42 27 5755 www.samsung.com 0900-SAMSUNG (0900-
NETHERLANDS WWW.Samsung.com
AUSTRIA 0810 - SAMSUNG (7267864, | /0 - ocom 7267864) (€ 0,10/Min) 9
€0.07/min) i 0 NORWAY 815-56 480 WWw.samsung.com
www.samsung.com/be POLAND 0801-1SAMSUNG(172-678) wwi.samsung.com
BELGIUM 09-201-24-18 (Dutch) +48 22 607-93-33
Www.samsung.com/be_ 808 20-SAMSUNG (808 20
fr (French) PORTUGAL 7267) WWw.samsung.com
BOSNIA 051331999 Www.samsung.com 08010 SAMSUNG (08010 726
BULGARIA 07001 33 11 WWw.samsung.com 7864) only from landline
ROMANIA .| Www.samsung.com
CROATIA 062 SAMSUNG (062 726 7864) | www.samsung.com (+40) 21 206 0110 from mobile 9
CZECH 800 - SAVISUNG (800-726786) | wrw.samsung.com and land line
DENMARK 70701970 Wi samsung.com SERBIA %gg)Samsung (0700726 | 0y samsung.com
FINLAND 030 - 6227 515 WWW.Samsung.com
0800 - SAMSUNG(0800-726
FRANCE 0148 6300 00 Wy, Samsung.com SLOVAKIA 786) | WAW.Samsung.com
01805 - SAMSUNG(726-7864 1-
GERMANY €0.14/Min) ( Www.samsung.com SPAIN g%) 1 - SAMSUNG (902 172 Www.samsung.com
CYPRUS 8009 4000 only from landline WWW.Samsung.com SWEDEN 0771 726 7864 (SAMSUNG) Www.samsung.com
80111-SAMSUNG (80111 726 www samsung com/ch
7864) only from land line Switzerland 0848 - SAMSUNG(7267864, | 1/ camsung.com/ch
GREECE (+30) 210 6897691 from mobilgy VWW-samsung.com CHF 0.08/min) it (French) 9 -
— ?)Zd;?)ng/‘;lr\}lZUNG — UK 0330 SAVISUNG (7267864) | vaww.samsung.com
h Do) 7; 7;34 ) | waw.5amsung.com ERE 0818717100 W samsung.com
S = 0113216(899' )| wwsamsung.Gom LTHUANA | 8.800-77777 WwwLsamsung.com
DRI ;61 B0 WWW.S8MSUNg.com LATVIA 8000-7267 AW Samsung.com
WWW.S8MSUNg.com ESTONIA 800-7267 VAW Samsung.com
MONTENEGRO | 020 405 888 www.samsung.com
Correct disposal of batteries in this product
(Applicable in the European Union and other European countries with separate battery return systems.)
This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed of
with other household waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate
that the battery contains mercury, cadmium or lead above the reference levels in EC Directive 2006/66.
If batteries are not properly disposed of, these substances can cause harm to human health or the environment.
To protect natural resources and to promote material reuse, please separate batteries from other types of waste and
recycle them through your local, free battery return system.
Correct Disposal of This Product (Waste Electrical & Electronic Equipment)
(Applicable in the European Union and other European countries with separate collection systems)
This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g.
. charger, headset, USB cable) should not be disposed of with other household waste at the end of their working life.

To prevent possible harm to the environment or human health from uncontrolled waste disposal, please separate these
items from other types of waste and recycle them responsibly to promote the sustainable reuse of material resources.

Household users should contact either the retailer where they purchased this product, or their local government office,
for details of where and how they can take these items for environmentally safe recycling.

Business users should contact their supplier and check the terms and conditions of the purchase contract.
This product and its electronic accessories should not be mixed with other commercial wastes for disposal.
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